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SETTING PREFERENCES (FIRST TIME ONLY) 

1. log on to FOIA Xpress 
2. From the home screen, go to Preferences under User Options 

3. In Preferences, 

a. Change Records per Page to 50 
b. Change Pages to View at a Time in Document Tree to 50 
c. Set Send Correspondence Default Email Address to Requester Email 
d. Change Image Zoom Factor to Actual Size 
e. Change Fill Mode for Redactions to Translucent 
f. Choose Redaction/Border Color and Back Color for redactions 

i. Qua IX Analysts will use True Red and light pink 
ii. Qua IX Reviewers will use Cobalt Blue Border and light blue fill 
iii. ICE Reviewers use Green (FP) or Purple (CPK) 

g. Choose ICE FOIA for Request Type 
h. Choose Single Folder for Default Format for Delivery/Save 
i. Choose PDF Tagged (508 Compliant) for Document Delivery Output Format 

j. Check the following boxes: 
L Unlock locked Folders When User Logs Out 

ii. Show Review Flags 
iii. Enable Auto Save for Review Layer 
iv. Display Redaction Codes by Selected Order 
v. Draw Redaction Using Double Click 

k. Choose default exemption codes (hold down Control Key and choose K2, b6, b7c} 
4. In top right on the screen, select Search Results View 

a. From the Select Request Fields box, select Requester, Primary, Status, Review Status, 
Assign Date 

5. Once changes have been made, click Save 

Page 1 of 129 

1 

FOIA Team SOP 

fill 

9-5-2014 



INPUT 

Choose a Case 
1. On S: drive; choose electronic case folder and move (not copy) into Analyst Work Folder. 

The priority order for processing ls: 
a. Oldest first 

2. From the S: drive; open the Request Letter file on screen to review and input information from 
the G-639 or G-28. (During training, print the pages for your reference.) 

Search Requester 
3. In FOIA Xpress, click Requester icon on panel and a Search Requester window pops up 
4. In the Search Requester window, enter either the law firm name under Organization or the 

requester's last name behind the asterisk. 
Example: *Law Offices of John Smith OR 
Example: *Smith 

5. Click Search at top toolbar 
a. If search comes up empty, select New (go to step 6) 
b. If requester is found, highlight the appropriate requester and continue to step 9 

Create a New Requester 
6. After selecting New, in the following information pertaining to the requester: 

a. Prefix: Mr. or Ms. 
b. First Name and Last Name 
c. Organization/Company: If Applicable (Example: Law Offices of ... ) 
d. Default Category is ALWAYS Private Individual 
e. Address Information 
f. Phone Number: If provided 
g. Email: If provided 

7. After filling in Requester information, click Save and answer Yes at the prompt 
8. Make sure the correct Requester is highlighted 

Create Request 
9. Click Create Request {all the info you just entered should be populated in the fields) 
10. In the General Information tab, 

a. Requested Date is the date on the G-639 
b. Received Date is today's date 

11. In the Other Information tab 
a. Type the NRC Number from the Referral Memo ln the Legacy Case Number field 
b. Enter the old FOIA case number assigned to ICE/Orlando backlog cases in the Additional 

Information (sic) field at the bottom. 
12. In the Request Information tab in the large blank box write as follows: records pertaining to 

(subject's name from G-639), (A-number) 
Example: records pertaining to Mary Jane Smith-Jones, A-123456789 
If A-number is not provided on the G-639, find it in the case documents 

13. Select the yellow paper clip icon and select Browse 
a. Find the Request Letter within your analyst folder on the S:drive and select Open 
b. Select Attach File and select OK 
c. Find the Referral Memo within your analyst folder on the S:drive and select Open 
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d. Select Attach File and select OK 
14. Click Save and answer Yes at the prompt 

Assign Case 
15. From the home screen, go to Primary Assignments under FOIAXpress Today. The case you 

created should appear at the top. 
16. Write the FOIA Xpress case number on the paper folder if you are working on an ICE/Orlando 

backlog case. 
17. Under the Actions option, select Assign Request 

a. Primary-Analyst's name 
b. Unclick the email notification boxes on the right 

18. Click Assign. The case status will read Assigned. 

Verify Consent and Perfect the Case 
19. Check G-639 for appropriate signatures. If signature is not ok, see PM for guidance. 
20. If signature ok, from the Primary Assignments screen, select Actions and click on Perfect 

Request 
a. Make sure today's date shows for date when case is to be perfected 
b. Click Save and the status of case should have changed to Perfected 

UPLOADING CASE DOCUMENTS 
Verify that the number of pages received is the same number of pages that were referred on the NRC 

Referral memo. If the page count is off, contact the PM before uploading and processing the case 

further. 

1. From FOIA Xpress Home page, click File Cabinet in the left panel 
2. Click Document Management 
3. Click New 
4. Enter the FOIA Xpress case number in the Folder Name field (Example: 2014-ICFO-00321) 
5. Click Save 
6. Click Open 
7. Click the check box next to the folder named with the FOIA Xpress number so that all three 

folders now show a check mark 
8. Right click on the case number 
9. Click lock 
10. Right click on the case number 
11. Click Create Section 
12. Enter 'Responsive Records' in the Section field 
13. Click Save 
14. Click Ok 
15. Expand the folder tree under the case number by clicking the plus sign that just appeared 
16. Click the check box next to the Responsive Records folder so that all four folders now show a 

check mark 
17. Right dick on the Responsive Records folder 
18. Click Add Pages 
19. Only one icon is available on the right side of the pop-up, click it (window icon with a yellow plus 

sign) 
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20. Navigate to the responsive records for this case and double click the file (or highlight the file and 
click Add} 

21. Click Add Pages 
22. Click Yes 
23. Click Ok 
24. Right click on the case number 
25. Click 'Add Folder(s) to' then select Review log 
26. Enter the FOIA Xpress case number in the Request ID field 
27. Click Search Requests 
28. Highlight the case 
29. Click the check box next to Responsive Records (all three should be checked now) 
30. Click Add Folder(s) 
31. Click Yes 
32. Click Ok 
33. Click No 
34. Click Home 
35. On S:drive ➔Qua IX folder ➔Analyst Work Folder, move the electronic case folder into the 

Completed Folder. Rename the file to the one ln FOIA Xpress (Example: 2014-ICFO-00321). 

4 
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PROCESSING THE CASE DOCUMENTS 
Open the case either through Document Management or View Documents from the Actions tab on the 
too/bar. load the pages by clicking on the case folder in the left panel. 

FUGITIVE CHECK: Do this step BEFORE redacting the case. See FUGITIVE PROCEDURES section. 

Fixing Pages 
1. The first page of the documents and any page that is difficult to read must be stamped with Best 

Available Copy. 
a. Click on the Stamp icon at the top menu and select BEST AVAILABLE COPY 
b. Draw a box at the bottom of the page. Best available copy will fill the box automatically. 

2. Rotate pages right-side up as necessary using icons on the top toolbar. 
3. Use the deskew icon on the top tool bar to better align the text of a page. 

Redacting 
4. Choose the Redact icon at the top menu. Draw a box around the information with your cursor. 

The default exemptions (k2, b6, b7c) will automatically fill the box. 
To change the exemption codes: 

a. Right dick on the redaction box and select Redaction Codes 
b. Uncheck the default codes and check the new exemptions codes 
c. If you select exemption b3, a pop-up box asks for the statute. Select 49 U.S.C. § 114(r). 
d. Click OK to close the box. 
e. Check the redaction box to be sure the correct exemptions appear in the box. 

5. After finishing the first page, a menu pops asking if you want to create a Review Layer. Select 
Yes and name it Highlighted Copy as the Review Layer, and select OK. 

6. Next to each page number in the panel on the left side of the screen are Review Flags that 
describe the status of the page: 

a. <Not Reviewed>: this page has not been reviewed for redactions 
b. <Reviewed>: this page had something added to the page but no redactions were applied 
c. <Disclosed in Part>: this page has been reviewed and redactions are applied to a part of 

the page 
d. <Released in Full>: this page has been reviewed with no redactions 
e. <Withheld>: this page has been reviewed and the entire page is being withheld in full 

7. To Release a Page in Full: 
a. Right click on the page itself or on the page number in the left-side panel 
b. Choose Review Flag in the pop up menu 
c. Select Released in Full 

8. To Withhold a Page in Full: 
a. Right click on the page itself or on the page number in the left-side panel 
b. Choose Redact in Full in the pop up menu 
c. The page will appear shaded and the default exemption codes will appear on the page 
d. Change the exemption codes as needed by right clicking on the page again and following 

the same instructions as above. 
e. Check the page to be sure the correct exemptions appear 

9. Once you have finished the last page of the case, make sure to select off the last page so it can 
save properly 

10 .. look at the Review Flag for every page in the panel on the left side of the screen to be sure that 
every page was reviewed and reads as Disclosed in Full, Released in Full, or Withheld. No Review 
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Flag should read <Not Reviewed> or <Reviewed>; correct any pages to show that they have 
been reviewed. 

11. Once you have finished with the redactions and it has been properly saved, select the Close icon 
at the top right of the screen 

CREATING THE RESPONSE LETTER 
1. From FOIA Xpress Home page, click on Primary Assignments and when the page opens, highlight 

the case number. Click on Correspondence in the toolbar and select Send 
2. In the box next to Select Letter Template, select the correct letter 

a. ICE Response to Requester (USCIS Referral) 
b. ICE Response to Requester (Fugitive Oisentitlement) 
c. Contact Supervisor if you can't determine appropriate letter 

3. Select Customize and Save for Final Response and wait for response letter to load 
4. Once the letter has loaded, proofread it carefully and make any corrections. 
5. Select Save For Final Response 
6. Once letter has been saved, Check the Correspondence Log that the status for the letter is 

Pending for Final Response; if it reads Pending, you must delete the letter and create a new one 

CHANGE CASE REVIEW STATUS TO REVIEW-OTHER AND ASSIGN TO QC 
1. Highlight the case number, click Actions in the top tool bar, and select Change Review Status 
2. Click on arrow for Set Status To and select Review-Other, then click Save 
3. On the Analyst's Primary Assignments screen, the Review Status will read Review- Other 
4. Click Actions again and select Assign Request. Click the boxes next to the QC reviewers' names. 

Unclick the boxes to send email, and then click Assign in the top toolbar. 
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MANAGING THE ANALYST'S PRIMARY ASSIGNMENTS QUEUE 
1. Cases stay in the Analyst's Primary Assignments queue until the case is finalized and closed. 
2. The Review Status tracks who has the case and what needs to be done with it (see table below). 
3. The Analyst can only see and work on cases that are assigned to them. 
4. Analyst work flow priority is: 

a. Closing cases with Review Status "Review Completed/Approved for Release" 
b. Correcting any cases Reassigned for Corrections 
c. Processing all cases assigned 

Review Status 
(blank) 
Pending Fugitive Check 
Review-Other 

Reassigned for Corrections 

Sent for Remote Review of Documents 

Means 
This case is waiting to be processed by the Analyst 
Case is on hold pending results of fugitive check 
Analyst has processed the case and submitted it to 
QC for review 
QC has reviewed the case and reassigned it back to 
the Analyst for Corrections 
QC has reviewed and sent the case for Director 
Review 

Signature Required/Correspondence Final Response Letter needs ICE signature (This status 
is used for fugitive response letters or special cases 
requiring a letter only) 

Review Completed/Approved for Release Case is ready for Analyst to Finalize and Close 

7 
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FINALIZING THE CASE: 
Confirm that the case status is Review Completed/Approved for Release. 

Finalize Review Layer and Move Docs from the Review Log to the Request Folder 
1. Click File Cabinet tab on left side of screen 
2. Click Document Management 
3. Enter the Folder Name or use the wild card and Click Search 
4. Click on the appropriate folder and click Open at top of screen 
5. Click on the case folder and when prompted, select and load the final, approved review layer 

(Highlighted Copy) 
6. Open the tree to see all the pages. Check that ALL pages have a review flag. 
7. Right dick folder on the case folder 
8. Click Add Folder(s) To 
9. Select Request Folder 
10. In the pop up box, the file name should appear in the Request ID box. In the Select Folder(s) 

section, click so all 3 folders are checked. Click Add Folder{s) 
11. A Review Status option will pop up, select Yes then OK when it says the files have been added. 
12. Another pop up box asks if you want to set Review Status, select Yes. In the next pop up box, 

choose Review Complete/Approved for Release and select OK. 
13. Close Document Management from icon and return to Primary Assignments. 

NOTE: The case status will have changed from Perfected to Documents Added. 

Finalize Exemptions 
14. From the Primary Assignments screen, select Actions and go to Final Actions 
15. In the Final Actions box, the request description, Action, and Exemption Codes should be 

prepopulated. {If the Actions field reads TBD, ask the PM for assistance before going further.) 
16. Under Discretionary Releases, select No (Our cases will always be NO) 
17. Select Save 

NOTE: The case status will have changed from Documents Added to Disposition Accepted 

Document Delivery 
Use the Document Delivery system to e-mail final responses with records. If not using Document Delivery 
to email, you still must complete the Document Delivery section with a different delivery mode, either CD 
or Mail. This is the only way that the system can track what records were released and when they were 
released. 

18. From the Primary Assignments menu, highlight the case that is ready to be delivered, click on 
Actions, then select Deliver Documents 

19. A Documents Delivery screen should open displaying the case documents. Click open the folders 
so you see all the pages. 

20. Check the box to the left of the case folder. All pages should now be checked as well. Be certain 
there is a checkmark next to every page. 

21. Click the Deliver Documents icon on the toolbar at the top of the screen and the Document 
Delivery for Request screen will open. Choose Delivery Options by clicking drop down box for 
Delivery Mode box and choose E-mail. The Requester's email (if available) should appear. 
Continue with instructions for Delivery Mode E-mail (below). 

22. If no Requester email appears, you must send the case by CD or by Mail. Click on Close at the 
bottom of the box to get out of the Deliver Documents mode WITHOUT delivering documents, 
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and continue to follow instructions for Delivery Mode CD and Diskette OR Delivery Mode Mail 
{below) 

Delivery Mode E�Mail: 
a. Check the Final Response Letter box, Select Default/Pending Final Response Letter 
b. Click on the Customize and Save button to open the Signed Response Letter 
c. CHECK THE LETTER CAREFULLY! Review the letter for any necessary corrections and 

confirm that the letter has been signed, then click Save and OK 
d. Include Review Objects: Make sure that there is a check next to the Stamp box. No 

check box next to Comments Box, Ellipse, or Sticky Note. 
e. Check box for Include Fully Redacted Pages 
f. Check box for Black & White 
g. Choose Bates Stamp and use case number as prefix; Preview Pages to check 
h. Output Format should be PDF Tagged (508 Compliant) 
i. Go to Step 23 to continue 

Delivery Mode CD and Diskette: If no email for requester and there are more than 21 

pages of case documents, then save the case documents to a disk and mail with the 

Response Letter. 

a. From Documents Delivery page (all pages still checked), click the folder and then 
click on the Save to Disk icon at the top tool bar 

b. Path: save to your desktop, then click OK 
c. Format: PDF Image 
d. Page Range: All 
e. Redactions: Redacted and Non Redacted Pages and check Include Fully 

Redacted Pages 
f. Fill Mode: Opaque 
g. Include Review Object: Check next to Stamp 
h. Select Bates Stamp and use case number as prefix; Preview Pages to check 
l. Click OK to save to disk 
j. Click Yes to open the file. Rename the file to match the case number if necessary. 
k. Bum the file to a disk (follow prompts on your computer) and write the name of the 

case on the disk. Make sure the file name and the disk name are the same as the 
case number. 

I. After burning the disk, open and check the disk to make sure the case is readable. 
Put the disk in a CD envelope. 

m. From Documents Delivery Screen, click on Deliver Documents icon at top toolbar 
n. Select Customize and Save the Final Response Letter to open the letter. Print the 

signed Response Letter. Put disk and letter in manila envelope. Write the address on 
the outside. 

o. Select CD and Diskette for Delivery Mode. 
p. Go to Step 23 to continue. 

Delivery Mode Mail: Use this method if there is no email for the requester and there are 

1-20 pages of case documents OR if the request is going to a detention center (Jail Mail). 

Always print two-sided (change your printer settings). Mail the case documents with the 

Response Letter. 
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a. From Documents Delivery page, click print icon at top tool bar 
b. Page Range: All 
c. Include Review Object: click Stamp 
d. Choose Bates Stamp and use case number as prefix, Preview Pages to check 
e. Click OK to print documents 
f. Click on Deliver Documents icon at top tool bar 
g. Select Customize and Save the Final Response letter to open the letter. Print the 

signed Response letter. Put letter and printed pages in appropriate envelope. 
h. Select Mail for Delivery Mode 
i. Go to Step 23 to continue. 

23. After completing the Document Delivery section, click Deliver Documents. A message will pop 
up telling you that "Job# is being processed and an email notification will be sent to you when it 
is complete." 

24. Close Documents Delivery screen using the Close icon to return to Primary Assignments screen. 
25. NOTE: The case status will have changed from Disposition Accepted to Delivery Pending. You 

MUST wait until you received the email notification from DHS that the documents have been 
successfully delivered before you can do to the next step. Once you receive the email 
notification, the case status will change from Delivery Pending to Documents Delivered. 

Close the Case 
26. From the Primary Assignments screen, highlight the case number you are working and select 

Actions and go to Close Request 
a. The box next to Closed Date, in the date the case was closed (today's date) 
b. For Review Status, dear status 
c. No. of Pages Released and No. of Pages Reviewed should be pre-populated and be the 

same value 
d. Select Save and select No to fees associates with this request 
e. Select Yes if you are sure you want to close the case (once closed, no editing can be 

done to the case) 
f. If the case is an Orlando/ICE backlog case with a paper file, write today's date and 

"Closed" on the front of the folder. Turn in the folder and any mail to PM. 
g. NOTE: Once the case has been closed properly, the case will disappear from the Primary 

Assignments screen. 
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FUGITIVE PROCEDURES 

Check for Fugitive Status 
1. Review ALL the documents for fugitive status. Refer to Check for Fugitive Status flowchart. 
2. If the case documents suggest that the subject could be a fugitive, change the case review status to 

Pending fugitive check, assign the PM as secondary user, and send the PM an email requesting a 
fugitive check. The email should include the following information: 

• Subject of email: Fugitive Check Case 2014-ICFO-00064 {cite the correct case number) 
• In the body of the email, 

o Subject's name as provided on the G-639, including any aliases 
o Subject's date of birth 
o Subject's country of birth 
o Subject's A-number(s) 
o Reference the page(s) that indicate fugitive status 

E-mail Exam le: 

....,,,....,..,,..,,,........."T"'TT..,.,..,.,,....,.,rtling warrant for removal dated 8/28/2007 
NO subsequent documents in the case 

• Attach the Request letter to the email for reference 
Go on to another case until the PM sends a response email on the fugitive status of the subject. 

Fugitive Check Response 
3. The PM checks the analyst's request for a fugitive check and forwards it to ERO. When ERO 

responds, the PM saves the response in the Correspondence log and then forwards the email to the 
analyst with any instructions. 

4. If the subject is NOT a fugitive, the analyst will process the case documents as usual. 
5. If the subject is a fugitive, the PM removes the case documents from the Review log. No documents 

will be processed or sent to the Requester. The analyst will prepare the Fugitive Response Letter and 
submit the case to QC for review. 

Finalizing a Fugitive Case 
6. Confirm that the case status is Review Completed/Approved for Release 
7. Click on Actions and select Final Actions. A pop up box will ask if you want to do this without adding 

any documents, answer yes. 
8. On the Final Actions screen, double click where it says TBD. Another box will open. In the Action 

field choose Other Reasons then scroll down to the bottom of the list of reasons and select Other­
Fugitive Status. Click on Apply at the top tool bar. 

9. Back on the Final Actions screen, confirm that the request information now reads fugitive status 
then click on Save at the top toolbar. The case status will have changed to Disposition Accepted. 

10. Select Actions ➔ Deliver Documents ➔ Deliver icon and attach the signed Fugitive Response letter 
the same way as a standard response letter (you are only sending the signed Fugitive Response 
letter; no case documents) 

11. Deliver letter (either email or print the letter and mail it) and close the case following the usual 
procedures in the SOP. 
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ICE FOIAXPRESS USER GUIDE 

SETTING PREFERENCES (FIRST TIME ONLY) 

l . Log on to FO IAXpress 
2 .  From the home screen, go to  Preferences under your name in the top right corner (ex: 

"John Smith") 
3 .  In Preferences, under General 

a. Change Records per Page to 50 
b. "Receive Job Email Notifications" box has been checked 
c. click Save 

4. In Preferences, under Request: 
a. Send Correspondence Default Email Address :  Requester Email 
b. Search Option: 
c .  Requester Search by Created Date: Descending 
d. Request Search Created Date: Descending 
e. Move following fields to Selected Request 

1. Request # 
Requester 

m. Primary User 
iv. Review Status 
v. Assigned Date 

f. Click Save 
5 .  In Preferences, under Document: 

a. Change Pages to View at a Time in Document Tree to I 00 
b .  Image zoom factor: 50% 
c. Redaction code(s ): (b )(6), (b )(7)(c) 
d .  mode for Redactions : Translucent 
e. Font for Redactions :  Arial 
f. Font size for Redactions: 8 

Redaction/Border Color for Redactions: Dark color 
Back color for Redactions: light color 

1. Redaction Code Alignment Preference: Top Left 
J . Default Format for Delivery/Save: S ingle Folder 
k. Document Delivery Output Fonnat: PDF Tagged (508 Compliant) 
L Boxes for Dravv Redaction Using Double Click,  Show Review Flags, and Display 

Redaction Codes by Selected Order should be "checked" 
m. Click Save 

6 .  In  Preferences, u nder Review Object: 

1 1/20117 

a. Change Straight Line to 3 and the color to red 
b. click Save 
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INPUT 

Choose a Case 
l .  On S :  drive; choose electroni c  case folder and move (not copy) into Analyst Work 

Folder. 
The priority order for processing is: 

a. Oldest first. 
2. From the S: drive; open the Request Letter file on screen to review and input information 

from the G-639 or G-28. (During training, print the pages for your reterence.) 

Search Requester 
3 .  In FOIA Xpress, cl ick Requesters icon on menu panel and select Search Requester 
4. In the Search Requester window, enter e ither the law fim1 name under Organization or 

the requester' s last name behind the asterisk. 
Example: *La\v Offices of John Smith OR 
Example: *Smith 

5. Click Search (belO\v) 
a. If search comes up empty, select New (go to step 6 )  
b .  I f  requester is found, h ighlight the appropriate requester and dick on  Review 

H istory to check for duplicate requests regarding the same subject. If no dupl icate 
requests are located, go to step 9. 

Create a Ne"' Requester 
6. After selecting New, fil l  in the fol lowing information pertaining to the requester: 

a. Prefix : Mr. or Ms. 
b.  F irst Name and Last Name 
c. Organization/Company: If Applicable (Example: Law Offices of . . .  ) 
d .  Default Category is  ALV./A YS Private Individual 
e. Address Infommtion 
f. Phone Number: If provided 
g. Emai l :  If provided 

7. After filling in Requester information, click Save and answer Yes at the prompt 
8. Make sure the correct Requester is highl ighted 

Create Request 
9. Click Create Request ( all the info you j ust entered should be populated in the fields) 
1 0. Enter the Requested Date (the date on the G-639) 
l l .  Under Description, type "records pertaining to Subject 's  Full Name, (A#)" {Note - -ffno 

A #  is provided, use date qlbirth) No end-of-sentence period is necessary, that i s  
automatically incorporated into the templates. 

1 2. Also under Description, Drag and Drop the incoming request and NRC referral memo 
into the "Drag and Drop Zone" 

1 3 .  Under Sub Requests, type the NRC Number from the Referral Memo in the Legacy 
Case Number AND USCIS Referral Number fields 

1 4. C lick Save at the bottom 

1 1 /20117 
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Assign Case 
1 5 .  From the individual case screen, click on Assign Users located on the left hand menu 

options 
1 6  . .  As the analyst, your name should be both the "Request Ovvner" (if you created the case) 

and the "Primary User''. To add a secondary user (ex: sending a case to your supervisor 
for review or assigning for a fugitive check): 

a. Click Add Users located in the middle of the screen 
b .  Type i n  the first name of the person you would like to add under Personal 

Information, First Name and click on Search 
OR 
Scrol l  through the list of names provided and select the box next to the person you 
would like to add and click Select 

1 7. Uncheck the boxes under Send Email (unless you have specific instmctions you are 
adding) 

1 8 . Click Assign at the bottom right 
1 9. Click Yes to confin11 the assignment or No to return to the screen to make changes 
20. Click OK 

Verify Consent and Perfect the Case 
2 1 .  Check G-639 for appropriate signatures. If signature is not ok, see PM for guidance. 
22. Click Set Perfect Status, then click save button. 

J\··IUL TI-TRACK REQUEST DETERMINATION (SIMPLE, COMPLEX, EXPEDITE) 

Process 
When a request is initially i nput by the intake team the FOIA assistant wil l  make a determination 
whether a request is simple or complex based upon the sensit ivity of the request description and 
the organization that the requester is a part of. After the search i s  completed the FOIA analyst 
must make a new determination on the correct request type, v .. 1hether being simple or complex, 
based upon the content and complexity of the documents that are provided by the program office. 
This determination by the FOIA analyst wil l  only be made based upon the content of the records, 
and not the size or volume of the records provided for processing. If the analyst deten11 ines that 
the request type should change, they have an obli gation to infonn their supervisor. The 
supervisor will then verify and provide their approval/disapproval to the analyst. 

1 .  The FOIA analyst will open all program office responses loaded in the correspondence 
log and on the s-drive (\vhen applicable). 

2 .  The analyst wil l  briefly review the records and the content provided by the program 
office. 

3. If it is detem1ined that the records no longer correspond to intake's initial detem1ination 
the analyst will assign the request to their supervisor and provide a brief explanation of 
why the request type should change. 

4. The supervisor then briefly reviews the records and contend provided by the program 
offices and either approves or disapproves the analyst 's  detennination. 

a. If the supervisor approves the analyst' s  new deten11ination they will assign the 
request back to the analyst. 

5 .  The analyst wi l l  then change the Multi-Track Type to  reflect the new request type. 
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a. Open the request 
b .  Select the dropdown next to  Multi-Track Type 
c. Choose either Simple, Complex, or Expedited 
d.  Scrol l  to the bottom of the screen and select Save 

6. The analyst proceeds to processing the records 

Definition * 
To the FOIA processing team, simple requests involve records that contain any of  the 
fol lowing: A-fi le  records that do not contain national security information; EARM or other types 
of database print outs; data pul ls  from information systems; human capital records including job 
announcement processing and interviev.r notes; contracts; SEVIS/SEVP records; detention 
facil ity inspections; detainee complaints and grievances; "no record" responses; requests where 
the majority of the records will be released or withheld in full ;  any document previously 
processed or posted on the FOIA webpage. 

To the FOIA processing team, complex requests i nvolve records that contain any of the 
fol lowing: national security infonnation; documents that are, or can be, politically sensitive in 
nature; records that require consultation ,vith another federal agency; detainee death 
investigations;  OPLA e-mail's containing legal guidance and discussion; HSI  investigative 
records; OPR i nvestigative records; 

To the FOIA processing team, Expedited requests only involve medical records. 

*Please note that these l ists are not exhaustive and requests containing records similar to what is 
presented i n  this definition should follow the same guidelines. 

Examples 
• 

• 

• 

• 
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A request is submitted from a media requester seeking documents that cou ld  be 
potent ially damaging to the agency if released, and would require searching multiple 
program offices . The FOIA assistant inputting the case determines that the request should 
be complex. Ifowever, after the searches are conducted and the request i s  assigned to the 
FOIA analyst, the analyst makes a determination that since the program office returned a 
"no records" response and no documents wil l  be released; the request type should  be 
changed to simple. 
USClS refetTals are typically simple cases, hmvever, ,vhen the records provided for 

processing contain ten·orist or other sensitive national security infonnation which 
requires a DC SME to process the request, the request type should be changed to 
complex. 
The intake team makes an initial detennination that a request is complex, but the program 
office produces a large number of Excel sheets in response to the search for records. As  
part of  the analyst 's  determination process they open the spreadsheets and find that none 
will require redactions and wil l  eventual ly  be released in full; the request type should be 
changed to simple, regardless of the volume of the spreadsheets provided. 
The intake team makes an initial determination that a request i s  simple and the analyst 
agrees with thi s  determination .  However, when the analyst takes a deeper dive into the 
records they determine that additional program offices need to complete as search .  After 
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these program offices finish their searches the analyst then determines that the records 
contain sensitivities and the request requires special handling; the request type should be 
changed to complex. 

• The intake team makes an initial detennination that a request i s  complex and five 
program offices are tasked for search. As part of the analyst's  detem1ination process they 
open the responses finding that a large number of documents will be withheld in tl1H and 
only  5 pages will be released in part; the request type should be changed to simple. 

UPLOADING CASE DOCUMENTS 
Ver�fj• that the number ofpages received is the sarne nwnber ofpages that 1vere referred on the 
NRC Referral memo. {lthe page count is o_ff, contact your supen'isor before uploading and 
processing the case jiu-th er. 

1 .  From the individual case screen, click Add/Search/View Documents from the left hand 
menu options 

2 .  Click Add Documents t o  upload new documents 
3 .  Under Option for Adding Pages, select the radio button next to  "Add all files to  a single 

folder" and type in the same FX folder number that appears below (ex: 201 7-ICF0-
12345) 

4. Drag and drop the responsive documents i nto the Drag and Drop Zone OR select 
Attach Files (within the Drag and Drop Zone) to browse your computer and select the 
files 

5. Click Add 
6 .  Click Yes 
7. The responsive records will appear under "Review Log Documents" --· check the box 

next to the file and click on Open Documents belmv 
8. In a separate tab, the Review Log will pop up. Maximize the document tree on the left­

hand side to reveal all the pages. 

PROCESSING THE CASE DOCUMENTS 

Fixing Pages 
1 .  The first page of the documents and any page that i s  ditlicult to read must be  stamped 

with Best Available Copy. 
a. Click on the Stamp icon on the right toolbar and select BEST AVAILABLE 

COPY 
b .  Draw a box at the bottom of the page. Best available copy will fi l l  the box 

automatically. 
2 .  Rotate pages right-side up as  necessary using icons on the right toolbar. 
3 .  Use the deskview icon on the top toolbar to  better align the text of  a page. 

Redacting 
4. Choose the Redact icon from the right toolbar. Dravv a box around the infomiation with 

your cursor. The default exemptions (b6, b7c) vvill automatically fill  the box. 
To change the exemption codes: 

a. Right click on the redaction box and select Redaction Codes 

1 1/20/17 

Page 1 9  of  129 

5 



b .  Uncheck the defaul t  codes and check the new exemptions codes 
c .  If you select exemption b3, a pop-up box asks for the statute .  Select 49 U.S.C.  § 

l 14(r). 
d .  Click OK to c lose the box. 
e. Check the redaction box to be sure the correct exemptions appear in the box. 

5 .  After finish ing the  first page, a rnenu pops asking if  you want to create a Review Layer. 
Select Yes and name it H ighlighted Copy as the Review Layer, and select OK. 

6 .  Next to each page number in  the panel on the l eft side of  the screen are Revie\\l F lags that 
describe the status of the page: 

a. <Not Reviewed>: this page has not been revie,ved for redactions 
b. <Reviewed>: this page had something added to the page but no redactions were 

appl ied 
c .  <Disclosed in  Part>: this page has been reviewed and redactions are applied to a 

part of the page 
d. <Released in  Full>: this page has been reviewed with no redactions 
e .  <Withheld>: this page has been reviewed and the entire page i s  being withheld in  

ful l  
7. To Release a Page in Ful l :  

a. Right cl ick on the page itself or on the page number in the left-side panel 
b .  Choose Review Flag i n  the pop up menu 
c .  Select Released in Full 

8 .  To Withhold a Page in Ful l :  
a .  Right cl ick on the page itself or on the page number in the left-side panel 
b.  Choose Redact i n  Ful l  in  the pop up menu 
c .  The page ,vi l l  appear shaded and the default exemption codes wi l l  appear on the 

page 
d .  Change the exemption codes as needed by right c l icking on the page again and 

fol lowing the same instructions as above. 
e. Check the page to be sure the correct exemptions appear 
f. Assign the c01Tect Reviev,' F lag 

9. Once you have finished the l ast page of the case, make sure to select off the last page so it 
can save properly 

1 0. Look at the Revievv Flag for every page in the panel on the l eft side of the screen to be 
sure that every page was reviewed and reads as Disclosed in Full, Released in  Full, or 
Withheld. No Review F lag should read <Not Reviewed> or <Reviewed>; con-ect any 
pages to shmv that they have been reviewed. 

1 1 . Once you have finished with the redactions and it has been properly saved, select the 
Close icon from the top toolbar (the last icon) 

CREATING THE RESPONSE LETTER 
1 .  From the individual case screen, select Correspondence from the left-hand menu 

options. 
2 .  Under the Send Correspondence tab, select Letter Template from the options on the 

right. Cl ick on Select Letter Template and choose the correct template, belmv are a few 
examples: 

1 1 120117 

a. ICE Response to Requester (USCIS Referral) for USCIS Refetnls 
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b .  ICE Response to  Requester (Fugitive Disentitlement) - for positive fogitives 
c. ICE Response to Requester (USCIS Withheld in for USCIS referrals that 

are completely withheld 
3 .  C li ck on  Customi.ze :for Final Response 
4.  Once the letter has loaded, proofread it  carefully and make any corrections. 
5 .  Select Save For Final Response 
6 .  Once letter has been saved, check the Correspondence Log that the status for the letter i s  

Pending for Final Response; if  i t  reads Pending, you must delete the letter and create a 
new one 

CHANGE CASE REVIE\V STATUS TO 3. REDACTION QC AND ASSIGN TO QC 
I .  From the individual case screen, select More Actions from the left-hand menu options. 
2 .  Click on Change Revie"" Status 
3 .  From the drop down menu next to  Set Request Status to: select 3 .  Redaction QC 
4. Click Save 
5. Click OK 
6. Assign to your supervisor, see "Assign Case" section in  SOP 
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MANAGING THE ANALY ST'S PRIMARY ASSIGNMENTS QUEUE 
1 .  Cases stay i n  the Analyst's Primary Assignments queue unti l the case i s  finalized and 

closed. 
The Review Status tracks v,rho has case and what needs to be done \Vith i t  
below). 

3 .  The Analyst can only see and work on cases that are assigned to them. 
4. Analyst work flow priority is :  

a. Closing cases with Review Status Close out" 
b. C01Tecting any cases Reassigned for Corrections 
c. Processing all cases assigned 

Review Status 
(blank) 

Means 
This case is waiting to be processed 
Analyst 

the 

Pending Fugitive Check Case is on hold pending results of fugitive check 

3. Redaction QC Analyst has processed the case and submitted it  to 
QC for reviev,,r 

Reassigned for Corrections QC has reviewed case and reassigned it back 
to the Analyst for Corrections 

Branch Chief RevieV1l QC has reviewed and sent the case for Director 
Review 

Signature Required/Correspondence Final Response Letter needs ICE signature (This 
status i s  used fugitive response letters or 
special cases requiring a letter only) 

4.Close Out Case is ready for Analyst to Finalize and Close 
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FINALIZING THE CASE: 
Cm?firm that the case status is "4. Close Out ". 
1\Tote: [h;ing the i\lext button action tabs, during the closing process is more efficient. 

Finalize Review Layer and Move Docs from the Re,1iew Log to the Request Folder 
1 .  From the individual case screen, click Add/Search/View Documents 
2. Check the box next to the documents under "Review Log Documents" and click Open 

Documents 
Click on the case folder and when prompted, select and load the final, approved review 
layer (Highlighted Copy) 

3.  Open the tree to see all the pages. Check that ALL pages have a review flag. 
4. Right click folder on the case folder 
5. Click Add Folder(s) To 
6. Select Request Folder 
7. In the pop up box, the fil e  name shou ld appear in the Request ID box. In the Select 

Fokier(s) section, click so all 3 folders are checked. Click Add Folder(s) 
8.  A Review Status option ,vill pop up, select Yes then OK when it  says the fi les have been 

added. 
9.  Another pop up box asks if  you want to set Review Status, select "no" 
10. Close Document Management from icon 

NOTE: The case status will have changed from Perfected to Documents Added. 

Finalize Exemptions 
11 .  From the individual case screen, select Final Actions 
12 . In the F inal Actions box, the request description, Action, and Exemption Codes should be  

prepopulated. ( If the Actions field reads TBD, ask the PM for assistance before going 
further.) 

13.  Under "Discretionary Releases", select No (Our cases will ahvays be NO) 
14. Select Save 

NOTE: The case status wi l l  have changed from Documents Added to Disposition 
Accepted 

Document Delivery 
Use the Document Delivery SJiStem to e-mailfina/ responses lvith records. {f not using Document 
Delivery to email, you still must complete the Document Delivet}' section 1rvith a different 
delive1J1 mode, either CD or Mail. This is the onl.,v ,vay that the system can track 1vhat record<: 
1tvere released and 1vhen they 1cvere released. 

18 .  From the individual case screen, select Deliver Documents on the left-hand menu 
1 9. Click "Deliver documents" (which will be the first option) 
20. A Documents Delivery screen should open displaying the case documents. Click the 

document tree box to open the folders so you see all the pages. 
2 1 .  Check the box to the l eft of the case folder. Al l  pages should now be checked as well .  Be  

certain there is  a checkmark next t o  every page (unless i t  i s  a duplicate page - those do 
NOT get delivered) 

22. C li ck the Deliver Documents icon on the toolbar at the top of the screen and the 
Document Delivery for Request screen wil l  open. Choose Delivery Options by clicking 
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drop dow11 box for Delivery Mode box and choose E-mail .  The Requester's  email ( if 
avail able) should appear, Continue with instructions for Delivery Mode E-mail (below). 

23 .  If no Requester email appears, you must send the case by CD or by Mail . Click on C lose 
at the bottom of the box to get out of the Deliver Documents mode WITHOUT delivering 
documents, and continue to follo,v instructions for Delivery Mode CD and Diskette OR 
Delivery Mode Mail (below) 

1 1 120117 

Delivery Mode E-Mail: 
a. Check the F inal Response Letter box, Select Default/Pending Final Response 

Letter 
b .  Click on the Customize and Save button to  open the Signed Response Letter 
c .  CHECK THE LETTER CAREFULLY! Review the letter for any necessary 

corrections and confirm that the letter has been s igned, then c lick Save and 
OK 

d. Choose the "ICE Response Email" response and c lick on customize to review 
the email being sent. C li ck save. 

e. Include Review Objects: Make sure that there is a check next to the Stamp 
box. No check box next to Comments Box, E l lipse, or Sticky Note. 

f Check box for Include Fully Redacted Pages 
g. Check box for B lack & White 
h. Choose Bates Stamp and use case number as prefix; Preview Pages to check 
h .  Output Format should be PDF Tagged (508 Compliant) 
i .  Check the box for passvvord protection 
j .  Go to Step 23 to continue 

Delivery Mode CD and Diskette: If no email for requester and there are more 
than 21 pages <�lease documents, then save the case documents to a disk and mail 
rvith the Response Letter. 
a .  From Documents Delivery page (all pages sti l l  checked), cl ick the fi le  folder 

and then click on the Save to D isk icon at the top toolbar 
b.  Path: save to your desktop, then cl ick OK 
c. Format: PDF Image 
d. Page Range: AU 
e. Redactions : Include Redacted and Non Redacted Pages and check Include 

Ful ly  Redacted Pages 
f. F i l l  Mode: Opaque 
g. Include Revie,v Object: Check next to Stamp 
h. Select Bates Stamp and use case number as prefix; Preview Pages to check 
i .  Click OK to save to disk 
j. Click Yes to open the file. Rename the file to match the case number if 

necessary. 
k. Burn the file to a disk (follovv prompts on your computer) and write the name 

of the case on the disk. Make sure the file name and the disk name are the 
same as the case number. 

1 0  
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I .  After burning the disk, open and check the disk to make sure the case is 
readable. Put the disk in a CD envelope. 

m. From Documents Delivery Screen, click on Deliver Documents icon at top 
toolbar 

n.  Select Customize and Save the F inal Response Letter to open the letter. Print 
the signed Response Letter. Put disk and letter in manila envelope. Write the 
address on the outside. 

o. Select CD and Diskette for Delivery Mode. 
p .  Go to Step 23 to continue. 

Delivery Mode Mail: Use this method !l there is no e1nailfor the requester and 
there are 1 -20 pages of case documents OR ((the request is going to a detention 
center (Jail Mail). Ahvays print two-sided (change your printer settings). ,rvtail the 
case documents with the Response Letter. 
a. From Documents Delivery page, click print icon at top tool bar 
b.  Page Range: All 
c .  Include Review Object: click Stamp 
d. Choose Bates Stamp and use case number as prefix, Preview Pages to check 
e. Click OK to print documents 
f. Click on Deliver Documents i con at top toolbar 
g. Select Customize and Save the Final Response Letter to open the letter. Prin t  

the signed Response Letter. Put letter and printed pages i n  appropriate 
envelope. 

h .  Select Mai l  for Delivery Mode 
1. Go to Step 23 to continue. 

23 .  After completing the Document Delivery section, click Deliver Documents. A message 
,�.ri l l  pop up telling you that "Job # i s  being processed and an email notification wil l  be 
sent to you ,vhen it is complete." If you "printed" the documents, they vvill be sent to you 
in a zip file through email. 

24. C lose Documents Delivery screen using the Close icon to return to Primary Assie,'llments 
screen. 

25.  NOTE: The case status ,vi l l  have changed from Disposition Accepted to Delivery 
Pending. You MUST wait until you received the email notification from DHS that the 
documents have been successfully delivered before you can do to the next step. Once you 
receive the email notification, the case status will  change from Delivery Pending to 
Documents Delivered. 

Close the Case 
23. From the individual case screen, select Close Request on the left-hand menu 
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a. The box next to Closed Date, fill in  the date the case \vas closed (today's date) 
b.  For Review Status, clear the status 
c .  No. of Pages Released and No. of Pages Reviewed should be pre-populated and 

be the same value 
d .  Select Save and select No to  fees associates with this request 
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e. Select Yes you are sure you want to close the case (once closed, no editing can 
be done to the case) 

f. NOTE: Once the case has been closed properly, the case will disappear from your 
Primary Assignments screen. 
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Intake FOIAXpress Overview 

1 .  Click on REQUESTS - Create Request 
1 . 1 .  Requester Details - Requester* 
1 .2. Click on box 
1 .3 .  Search email first (if supplied) 
1 .4. Search first/last name 
1 .5 .  If not in system, c lick Create Requester tab 
I .6. Mr. or Ms. / FIRST l LAST middle name not required here 
1 .7 .  Phone/emai l  ( if provided) 
1 .8 .  Organization (Law Finn/School etc.) 
1 .9 .  Category*- Attorneys = Commercial Organization 
1. 1 0. Address 1 = Street Address 
1 . 1 1 . Address 2 = Suite/Apt # 
1 . 12 .  Cli ck "Save" 
1 . 1 3 . If the requester is  already i n  the system, the profile wi l l  pop up 
1 . 14. C lick "Select" and infonnation vvil l  auto-populate 
1 . 1 5. Request h istory - No 

2. Request Detail s  
2 . 1 .  Received Mode •- select email/fax/mail 
2 .2 .  Multi-Track Type Simple/Complex/Expedite 
2 .3 .  --Simple = tasked to ERO or a basic  request. Based on content. 
2 .4. --Complex = based on content 
2 .5 .  --Expedite = Medical Records or Removal Proceedings (proofrequired) 
2.6 .  Requested Date Mail = date on letter, email = date of email, fax = date on fax 
2.7 .  Received Date •····· Mail = todays date, email = date of email ,  tax = date on fa'< 
2 .8 .  Priority- select High for high profile cases or keep Normal for non-high profile cases. 
2 .9 .  Delivery Mode - email is primary ( if provided) or mail 
2 . 1 0. Method of payment - N/A 
2 . 1 1 .  Description - "all records pertaining to" FIRST/1v1IDDLE/LAST, ALIASES, 

DOB XX/XX/XX, COB: XXXXXX, A-XXX XXX XXX (use 0-639 for all info i f  
provided) 

2 . 1 2. Emailed requests - drag/drop emai l  to desktop then drag/drop into "Drag and 
Drop Zone" 

2 . 1 3 . Fax/Mailed requests - Scan in / Scan to Folder, save, OK (should show up on 
desktop) 

2 . 14. Drag/Drop into Drag and Drop Zone 
2 . 1 5 .  Save Request ( this wi l l  generate your ICFO tracking number 20 1 7-ICFO-

XXXXX), status will change to "Received", move scanned request to recycle bin (write 
ICFO number on fo lder) 

2 . 1 6. S taple mail/faxes together and place into folder 
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3 .  Assign Users 
3 . 1 .  Primary User - click on box, selec ,__ ___ _. 
3 .2 .  Uncheck "send email notification" 
3 .3 .  C lick red "X" next to your name, click OK 
3 .4. C lick Assign, OK (status should change to "Assigned") 
Request for Documents 
4. 1 .  New 
4.2. Due Date - 1 4  days down) 
4.3. Priority - Normal 
4.4. Add Program Offices 
4.5. Check ERO (Enforcement and Removal not ERO Litigation) 
4.6. Select 
4.7.  Next 
4 .8 .  Add From: Disk 
4.9. Drag/Drop Search Fonn, Drag/Drop Suspense Tracker 
4. 10 .  Click "Add to List" 
4. 1 L Add From: Correspondence Log 
4. 1 2 . Request Description Select (should nmv have 3 i tems in the Attach to RFD box) 
4. 1 3 .  Email Options: Template ICE Tasking Email (will auto populate) 
4. 1 C li ck "email"  
4. I 5 .  Check the 3 documents attached, cl ick OK 
4. 1 6. Job Status = Complete, C lose V·lindow 
4. 1 7. Status should change to "Request for Docs Sent" (0/ 1 ) 

5 .  Correspondence Send Correspondence (if email address i s  provided , i t  wi l l  auto populate) 
5 . 1 . Email Options: Template - ICE Ack (standard) 
5 .2 .  Delete non-applicable categories (Attorneys are Commercial Requesters) 
5 . 3 .  Send Emai l  
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Intake FOIAXpress Guide 

PRINTING CORRESPONDENCE 

(NO EMAIL PROVIDED) 

1 .  Cl ick on REQUESTS - Create Request 
1 . 1 .  Requester Detail s  - Requester* 
1 .2. Click on box 
1 .3 .  Search first/last name 
1 .4. If not in system, cl ick Create Requester tab 
1 .5 .  Mr. or Ms. I FIRST / LAST middle name not required here 
l .6 .  Phone (if provided) 
l .7 .  Organization (Law Firm/School etc.) 

1 .8 .  Category*- Attorneys = Commercial Organization 
1.9 .  Address 1 = S treet Address 
1 . 10. Address 2 = Suite/Apt # 
1 . 1 1 .  Cl ick "Save" 
1 . 1 2. If the requester i s  already in  the system, the profile will pop up 
L 1 3 . Cl ick "Select" and infom1ation wi l l  auto-populate 
1 .  1 4. Request history - No 

2. Request Details 
2. 1 .  Received Mode - select email/fax/mail 
2.2. Multi-Track Type - Simple/Complex/Expedite 
2 .3 .  --Simple = tasked to ERO or a basic request Based on content 
2.4. --Complex = Based on content 
2 .5 .  --Expedite = Medical Records or Removal Proceedings (proofrequired) 
2.6 .  Requested Date Mail = date on letter, emai l  = date of email, fax = date on fax 
2 .7 .  Received Date - Mail = todays date, email = date of emai l ,  fax = date on fax 
2 .8 .  Priority- select High for h igh profile cases or Normal for non-high profile cases 
2 .9 .  Delivery Mode -Mail 
2 . 10. Method of payment -- N/ A 
2 . 1 1 .  Description "al l  records pertaining to" FIRST/MIDDLE/LAST, ALIASES, 

DOB XX/XX/XX, COB: XXXXXX, A-XXX XXX XXX (use G-639 for all info if  
provided) 

2 . 1 2. Emailed requests - drag/drop email to desktop then drag/drop into "Drag and 
Drop Zone" 

2 . 1 3 .  Fax/Mailed requests - Scan in / Scan t o  Folder, save, OK (should show up  on 
desktop) 

2 . 14. Drag/Drop into Drag and Drop Zone 

1 1 /'20/17 

Page 29 of 129 

1 5  

-



2 . 1 5 . Save Request (thi s  generate your ICFO tracking number 201 7-ICFO-
XXXXX), status wi l l  change to "Received", move scanned request to recycl e  bin (,vrite 
ICFO number on folder) 

2 . 1 6. Staple mail/faxes together and place  into folder 
3. Assi 1m Users 

3 . 1 .  Primary User click on box, select b}(6); (b)(?)( click "Select" 
3 .2 .  Uncheck "send email notification" 
3 .3 .  C lick red "X" next to your name, click OK 

C lick Assign, Yes, OK (status should change to "Assigned") 
Request for Documents 
4. 1 .  New 

Due Date - 14 days down) 
4.3 . Priority - Normal 

Add Program Offices 
4.5 . Check ERO (Enforcement and Removal not ERO Litigation) 
4.6. S elect 
4.7. Next 
4 .8 .  Add From: Disk 
4 .9 .  Drag/Drop Search Fonn, Drag/Drop Suspense Tracker 
4. 10. C lick "Add to List" 
4. 1 1 . Add From: CotTespondence Log 
4. 1 2. Request Description Select (should now have 3 items in the Attach to RFD box) 
4 . 1 3 .  Email Options: Template ICE Tasking Email (will auto populate) 
4. 14. Click "email"  
4 . 1 5 .  Check the 3 documents attached, click OK 
4. 1 6. Job Status = Complete, C lose Windm:v 

1 7. Status should  change to "Request for Docs Sent" (0/1 ) 
5 .  CoITespondence - Send Correspondence 

5 . 1 .  Add From: Letter Template 
5 Select Letter Template: select applicable letter template 
5 . 3 .  Customize 
5 Edit l etter 
5 .5 .  Drag/Drop Signature 
5 .6 .  Double click on signature / Wrap Text / Beh ind Text / shrink to fit 
5 File Print /Print 
5 . 8. Add to List 
5 .9 .  D ispatch Mode: Print radio  Button (delivery Mode should change to Mail) 
5 . 10. Print Opt.ions Subject Type in subject letter Print - Ok 
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Intake FOIAXpress Guide 

3rd Party / ID Cert 

(Stop/Start Clock) 

Detennine if the requester is seeking records pertaining to them or if they are requesting 
records pertaining to a third party (most cases an attorney seeking records for his client.) 
Requests must contain a signature from the subject of the request either verifying their 
identity under penalty of perjury or their signature authorizing the release of their 
infonnation to a third party. 

1 .  Click on REQUESTS -- Create Request 
1 . 1 .  Requester Details Requester* 
1 .2 .  Cl ick on box 
1 .3 .  Search email first ( if supplied) 
1 .4. Search first/last name 
1 .5 .  If not in system, click Create Requester tab 
1 .6. Mr. or Ms. / FIRST / LAST middle name not required here 
1 .7 .  Phone/email (if provided) 
1 .8 .  Organization (Law Firm/School etc. )  
l . 9 .  Category*- Attorneys = Commercial Organization 
I .  1 0. .Address 1 = Street Address 
1 . 1 1 . Address 2 = Suite/ Apt # 
1 . 12 .  Click "Save" 
L 1 3 . If the requester is  already in the system, the profile will pop up 
1 . 1 4. Click "Select" and information \Vill auto-populate 
1 . 1 5 .  Request history -No 

2. Request Details 
2 . 1 .  Received Mode •- select email/fax/mail 
2 .2 .  Multi-Trnck Type - S imple/Complex/Expedite 
2 . 3 .  --Simple = tasked to ERO or a bas ic  request. Based on content 
2 .4. --Complex = based on content 
2 . 5 .  --Expedite = M edical Records or Removal Proceedings (proof required) 
2 .6 .  Requested Date - Mail = date on letter, email = date of email, fax = date on fax 
2. 7. Received Date - Mail = todays date, email = date of email, fax = date on fax 

2 .8 .  Priority- select High for high profile cases and N01111al for non-high profile cases 
2 .9 .  Delivery Mode - email is primary ( if provided) or mail 
2 . 1 0. Method of payment - N/ A 
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2 . 1 1 .  Description - "all records pertaining to" FIRST/MIDDLE/LAST, ALIASES, 
DOB XX/XX/XX, COB: XXXXXX, A-XXX XXX XXX (use G-639 for all info if  
provided) 

2 . 1 2 . Emailed requests - ·  drag/drop email to desktop then drag/drop into "Drag and 
Drop Zone" 

2 . 1 3 . Fax/Mailed requests -·- Scan in / Scan to Folder, save, OK (should show up on 
desktop) 

2. 1 4. Drag/Drop into Drag and Drop Zone 
2 . 1 5 . Save Request (this will generate your ICFO tracking number 201 7-ICFO-

XXXXX), status wil l  change to "Received", move scanned request to recycle bin, \Vrite 
ICFO number, 3rd Paiiy/ID Cert, Date (30 days) 

2 . 1 6. Staple mail/faxes together and place i nto folder 
3. Assign

. 
Users . b)(6) ;(b)(?)( 

3 .  L Prnnary User - chck on box, selec ) click "Select" 
3 .2 .  Uncheck "send email notification" 
3 .3 .  C lick red "X" next to your name, cl ick OK 
3.4. C lick Assign, Yes, OK (status should change to "Assigned") 

4. Correspondence - Send Correspondence (if email address is provided , it \Vill auto populate) 
5 .  Add From: Letter Template - Select Letter Template - cl ick on ICE 3 rd Party Consent Forni 

or ICE Certification of Identity (Compatibil ity Mode) 
5 . l. Customize 
5 .2 .  Add to List 
5 .3 .  Email Options :  Template select ICE NMI 3rd Party Release or Deceased or NMI Cert 

of ID 
5 .4. for 3rd Party delete the option that is not needed (either third party authorization or proof 

of death) 
5 .5 .  Send Email 

6. Stop the Clock 
6 . 1 .  Reason for Stopping the Clock* - Request Not Perfected 
6 .2. Stop Clock Date - Todays Date 
6 .3 .  Options - Create Task Reminder 
6 .4 .  Stop the C lock/OK 
6 . 5 .  Create New Reminder 
6 .6 .  Task• - On Hold Need Info/Clarifi cation 
6. 7. Due Date* - If requester provides an email address, 30 days. 
6 .8 .  Reminder Details - ID Cert or 3rd Party 
6 .9. Remind l Days before due date 
6 . 1 0. Remove your  name from request (both red "X") 
6 . 1 l. Save 
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Upon receipt of ID Certification or 3rd Party Authorization, the documents need to be 
uploaded to the Correspondence Log, Clock Started, and Documents requested and 
acknowledgment letter sent to requestor. 

l .  Search for request - Type in 201 7-ICFO-XXXXX number associated with the request 
1 . 1 .  For mail/fax, scan the document/scan to folder/save/ok (should appear on your desktop) 
1 .2. For email, drag/drop the email to your desktop 

2.  Start the C lock - annotate in the Notes Box "ID Cert rcvd / 3rd Party rcvd xx/xx/xx" - Save 
3 .  Correspondence - Receive Correspondence - Subject - type in  "ID Cert or 3rd Party" 

3 . 1 .  Received Mode - Mail/Email/fax 
3 .2 .  Drag/Drop ID Cert/3

rd Party to the Drag and Drop Zone Save/OK/OK 
4. Request for Documents 

4 . t. New 
4.2 .  Due Date - 30 days 
4.3. Priority - Normal 
4.4. Add Program Offices 
4 .5 .  Check ERO (Enforcement and Removal not ERO Litigation) 
4.6. Select 
4.7. Next 
4.8. Add From: Disk 
4.9. Drag/Drop Search Form, Drag/Drop Suspense Tracker 
4. 1 0. Click "Add to List" 
4 . 1 1 .  Add From: Correspondence Log 
4. 1 2. Check both the Request Description and the ID Cert/3rd Party Authorization 

(should now have 4 items in the Attach to RFD box) 
4. 1 3 . Email Options: Template ICE Tasking Email (\Vill auto populate) 
4. 14. Click "email" 
4 . 1 5 . Check the 4 documents attached, cl ick OK 
4. 1 6. Job Status = Complete, Close Window· 
4. 1 7 . Status should change to "Request for Docs Sent" (0/1 ) 
4. 1 8. Correspondence - Send Correspondence ( if email address is provided , i t  will auto 

populate) 
4 . 1 9. Email Options : Template - ICE Ack (standard) 
4.20. 
4 .2 1. 
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Intake FOIAXpress Guide 

CBP/USCIS REFERRAL 

1 .  Cl ick on REQUESTS - Create Request 
1 . 1 .  Requester Detai ls •- Requester* 
1 .2 .  C lick on box 
1 .3 .  Search ernail first (if suppl ied) 
1 .4 .  Search first/last name 
1 .5 .  If not in system, c l ick Create Requester tab 
1 .6 .  Mr. or Ms. / FIRST / LAST middle name not required here 
1 .7 .  Phone/emai l  ( if provided) 
1 . 8 .  Organization (Law Firm/School etc. )  
1 .9 .  Category*- Attorneys = Commerc ial Organization 
1 .  10 .  Address 1 = Street Address 
1 . 1 1 .  Address 2 = Suite/ Apt # 
1 . 1 2. Click "Save" 
1 . 1 3 . If the requester i s  already in the system, the profi1e will pop up 
1 . 1 4. Click "Select" and infonnation will auto-populate 
1 . 1 5 .  Request h istory - No 

2. Request Details 
2 . 1 .  Received Mode - select email/fax/mail 
2 .2 .  Multi-Track Type S imple/Complex/Expedite 
2 .3 .  --Simple = tasked to ERO or a basic request. Based on content 
2.4. --Complex = based on content 
2 .5 .  --Expedite = Medical Records or Removal Proceedings (proof required) 
2.6. Requested Date Mail = date on letter, email = date of email, fax = date on fax 
2 .7 .  Received Date Mail = todays date, email = date of email ,  fax =  date on fax 
2 .8 .  Priority- select High for high profile cases or select Nonnal for non-high profile requests 
2 .  9. Delivery Mode email is primary (if provided) or mail 
2. 10 .  Method of payment - N/ A 
2 . 1 1 . Descliption - "all records pertaining to" FIRST/MIDDLE/LAST, ALIASES, 

DOB XX/XX/XX, COB: XXXXXX, A-XXX XXX XXX (use G-639 for all info i f  
provided) 

2 . 1 2. Emailed requests - drag/drop emai l  to desktop then drag/drop into "Drag and 
Drop Zone" 

2 . 1 3 . Fax/Mailed requests - Scan in / Scan to Folder, save, OK (should show up on 
desktop) 

2 . 14 .  Drag/Drop into Drag and Drop Zone 
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1 5 . Save Request (this  your ICFO tracking number 20 1 7- ICFO-
XXXXX), status will change to "Received", move scanned request to recycle bin (write 
ICFO number on folder) 

2 . 1 6. S taple mail/faxes together and place into folder 
3. Assign Users 

3 . 1 .  Primary User click on box, select B il l  Coker, click "Select" 
3 .2 .  Uncheck "send email notification" 
3 .3 .  Click red "X" next  to your name, click OK 
3 .4. Click Assign, Yes, OK (status should change to  "Assigned'') 

4. Request for Documents 
4. 1. Ne\\l 
4. Due Date - 14  days (2 down) 
4.3 .  Priority - Normal 
4.4. Add Program Offices 
4.5 . Check ERO (Enforcement and Removal not ERO Litigation) 
4.6. S elect 

Next 
4.8. Add From: Disk 
4.9. Drag/Drop Search Fonn, Drag/Drop Suspense Tracker 
4. 1 0. Click "Add to List" 
4. 1 1 . Add From:  Conespondence Log 
4. 1 2. Request Description Select (should now have 3 i tems in the Attach to RFD box) 
4. 1 3 .  Email Options: Template ICE Tasking Email (\'v' il l  auto populate) 
4 . 14. Click "email" 
4. 1 5 . Check the 3 documents attached, click OK 

1 6. Job Status = Complete, C lose Window 
1 7. S tatus should change to "Request for Docs Sent" (0/1 ) 

5 .  CotTespondence - Send CotTespondence ( if address is provided , i t  will auto populate) 
5 . 1 .  Add From: Letter Template - Select Letter Template - ICE Ake Letter (Transfer to CBP 

or USCIS) 
5 . 2 .  Customize 
5 .3 .  Drag/Drop Signature - Double Click - Wrap Text - Behind Text - shrink to - Add to 

List (repeat if needed for USCIS Letter) 
5 .4. Email Options: Template ICE Ack (standard) 
5 .5 .  Delete all non-applicable categories (Attorneys are Commercial Requestors) 
5 .6 .  Send Email 
5 Add From: Letter Template Select Letter Template ICE Transfer Memo to CBP or 

USCIS 
5 .8 .  Customize 
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5 .9 .  Drag/Drop S ignature - Double Click - Wrap Text - Behind Text - shrink to - delete 
from ''OR through second paragraph - Add to List 

5 . 1 0. Add From:  C01Tespondence Log Request Description Select 
5 . 1 1. Email Options Template ICE Transfer to Other Agency Email 
5 . 1 2. Click "Other" radio button �----------� 
5 . 1 3. To* For CBP (b)(6) ; (b)(?)(C) nd CC: (b )(6) ; (b )(7)(C) 
5 . 1  
5 . 1 5 .  
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Intake FOIAXpress 

Non- DHS Referral Guide 

l .  Click on REQUESTS - Search Requests 
1 .  I .  Search Criteria Request Type Uncheck "ALL", Check "ICE FOIA" 
1 . 2 . + Custom Fiekis 
1 .3 .  Enter NRC number into Component Legacy Case Nun1.ber Box 
1 .4. C lick "Search" 
1 .5 .  If "No", click OK 
1 .6 .  Cut and Paste NRC Number into USCIS Referral Number Box 
1 .7 .  If "No", Click OK 

2. Cl ick on REQUESTS - Create Request 
2 . 1 .  Requester Detai ls Requester* 
2 .2 .  C lick on box 
2 .3 .  Search email first (if supplied) 

2.4. Search first/last name 
2 .5 .  If not in system, c lick Create Requester tab 
2.6 .  Mr. or Ms. / FIRST / LAST middle name not required here 
2. 7 .  Phone/ email ( i f  provided) 
2 .8 .  Organization (Law Firm/School etc.)  
2 .9 .  Category*- Attorneys = Commercial Organization 
2 . 1 0. Address 1 = Street Address 
2 . 1 1 . Address 2 = Suite/ Apt # 
2 . 1 2. Click "Save" 
2 . 1 3 . If the requester is  already in  the system, the profile will pop up 
2 . 14 .  C lick "Select" and information ,vi l l  auto-populate 
2 . 1 5 . Request H istory No 

3 .  Request Details 
3. 1 .  Received Mode select email/fax/mail 
3 .2 .  Requested Date - Mail = date on original request, email = date of email ,  fax = date on 

fax 
3 .3 .  Received Date - Mail = todays date, email = date of email ,  fax = date on fax 
3 .4 .  Delivery Mode - email i s  plimary (if provided) or mail 
3 . 5 .  Method of payment - N/A 
3 .6 .  Description - "all records pertaining to'' FIRST/MIDDLE/LAST 
3 .7 .  Legacy case Number - Input USCIS referral number (NRC201 XXXXXXX) 
3 .8. This will allow the response letter to the requestor to be auto-populated with NRC 

Number 
3 .9 .  USCIS Referral Number - Input USCIS referral number (NRC20 1XXXXXXX) 
3 . 1 0. Mailed requests Scan i n / Scan to Folder, save, OK (should shmv up on desktop) 
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3 . 1 L S taple request documents together and paperclip disc to documents, place into 
folder 

3. 1 2. If responsive documents (paper) are included, do not scan those into the system 
(paperclip together and place  in folder) 

3 . 1 3 . Drag/Drop into Drag and Drop Zone 
3 . 1 4. Save Request ( this wil l  generate your ICFO tracking number 20 17-ICFO-

XXXXX), status will change to "Received", move scanned request to recycle bin , write 
TBP and # of CD's or pages and ICFO number on 

4. Assign Users- Non-High Profile Requests 
1 .  Primary User - click on box, select a Supervisor, click "Select" 

Uncheck email notification" 
. C lick red "X" next to your name, click OK 

4.4. C lick Assign, Yes, OK (status should change to "Assigned") 
5 .  Assign Users- High Profile Requests 

5 . 1 .  Primary User - click on box, select Fernando Pineiro, click "Select" 
5 .2 .  Uncheck "send email notification" 
5 . 3 .  C lick red "X" next to your name, click OK 
5 .4. C lick Assign, Yes, OK (status should change to  "Assigned") 
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Intake FOIAXpress GUIDE 

FEE W AIYER/EXPEDITE 

1 .  Click on REQUESTS - Create Request 
1 . 1 .  Requester Details Requester* 
1 .2 .  Click on box 
1 .3 .  Search email ( if supplied) 
1 .4 .  Search first/last name 
1 .5 .  If not in system, click Create Requester tab 
1 .6 .  Mr. or Ms. / FIRST / LAST middle name not required here 
1 Phone/email (if provided) 
1 .8 .  Organization (Law Film/School 
1 .9. Category*- Attorneys = Commercial Organization 
1 . 1 0. Address l = Street Address 
1 . 1 1 .  Address 2 = Suite/ Apt # 
1 .  1 2. C lick "Save" 
1 . 1 3 . If the requester is already the system, the profil e  wil l  pop up 
1 . 14. "Select" and infomrntion v.,,i l l  auto-populate 
1 . 1 5 .  Request history - No 

2. Request Details 
1 .  Received Mode - select email/fax/mail 

2.2 .  Multi-Track Type S imple/Complex/Expedite 
2 . 3 .  --S imple = tasked to ERO or a basic request. Based on content 
2.4. --Complex = based on content 
2 .5 .  --Expedite = Medical Records or Removal Proceedings (proof required) 
2.6 .  Requested Date Mail = date on letter, email = date of email, fax = date on 
2.7 .  Received Date Mail = todays email = date of email, fax = date on fax 
2.8 .  Priority- select High for h igh profile cases or select Nonnal for non-high profile cases 
2.9. Delivery Mode email is primary (if provided) or mail 

10. Method of payment - N/A 
l 1 .  Description - "all records pertaining to" FIRST/MIDDLE/LAST, ALIASES, 

DOB XX/XX/XX, COB: XXXXXX, A-XXX XXX XXX (use G-639 for info if 
provided) 

1 2. Emailed requests - drag/drop email to desktop then drag/drop into "Drag and 
Drop Zone" 

2. 1 3 . Fax/Mailed requests - Scan in / S can to Folder, save, OK (should show up on 
desktop) 

2. 1 4. Drag/Drop into Drag and Drop Zone 
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1 5 . Save Request (thi s  your ICFO tracking number 201 7-ICFO-
XXXXX), status \Vill change to "Received", move scanned request to recycle bin (write 
ICFO number on folder) 

2 . 1 6. Staple mail/faxes together and place into folder 
3. Assign Users (b)(6);(b)(7)(C) 

3 . 1 .  Primary User cl ick on box, selec 
3 .2 .  Uncheck "send email notification" 
3 .3 .  Click red "X'' next to your name, click OK 

cl ick ''Select" 

Click Assign, Yes, OK (status should change to "Assigned") 
Request for Documents 

1 .  New 
4.2. Due Date - 1 4  days (2 down) 

Priority - Normal 
Add Program Offices 

4 .5 .  Check ERO (Enforcement and Removal not ERO Litigation) 
4.6.  Select 
4.7.  Next 
4.8 .  Add From: Disk 
4 .9 .  Drag/Drop Search Fonn, Drag/Drop Suspense Tracker 
4 . 1 0. Click "Add to List" 
4 . 1 L Add From: Correspondence Log 
4. 1 2. Request Description Select (shoul d  now have 3 items in the Attach to RFD box) 
4. 13 .  Email Options: Template ICE Tasking Email (will auto populate) 
4 . 1 4. Click "email" 
4. 1 5 . Check the 3 documents attached, dick OK 

1 6. Job Status = Complete, C lose Window 
4. 1 7. Status should change to "Request for Docs Sent" (0/1) 

5 .  Cmrnspondence - Send Correspondence ( i f  email address i s  provided , it \:i.1i l l  auto populate) 
5 .1 . Email Options: Template - ICE Ack (standard) 
5 Delete all non-applicable categmies (Attorneys are Commercial Requestors) 
5 .3 .  Send Email 
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Microsoft Excel Document Prep for FOIA 

Please note that all Microsoft Excel spreadsheets are required to be reviewed by the Deputy 

FOIA Officer prior to release, regardless if the request is high profile or not. 

1 .  Unhide All Rows/Columns/and Sheets 

ookl.xl icrosoft Exce 

Instrt P!IIOt L..a:,out Formulas Data Review VIM Add-Ins Acrobat 

• ll • 

B I !! • K A. 
� .  a ·  

Gen Hal ... � Conditional Formatting ... 

$ .. % � Format as Table .. 

i� � �... �08 +�8 � Cel t  Styles ... 

d-lmert - l: ... " 
� Delete • iiJ • Z 

. 
� 

Sort & Fine! & 
:€1Forrnat:I .2 • fitter• Select • 

=""===F•=n=l ===''==;=Al=•o=nm=•n=l=='•,.,,,,,
N
,,,u,,,mb,,,•r=='• ====Sty1=•=• ===='= C�I Size 

=====;:===-==b=============;======= ! O Rowlieight . . .  

Cl1pDo!rd ,. 
Cl9 

A B 
1 
2 
3 
4 
5 
6 
7 
B 
9 
10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
20 
21 

◄ ► ►I Sheetl 

C D G H 

Sheet3 � 

�utofit Row Height 

ri Column �dth ... 

Autof!t Column Width 

Ben11me Sheet 

,Move or Copy Sheet. .. 

Iab Color 

Prot:tttion 

frotut Sheet ... 

I� 1ockCell 

Format C!IIS . .  , 

Rn<ty I 

• Open the Excel spreadsheet. Click the Home button in the ribbon on the top of your 
screen 

• Click the icon titled Format/ select the Hide & Unhide option/cl ick Unhide Sheet 
• If any sheets are hidden you will receive a warning asking i f  you wouJd l ike for the sheet 

to be unhidden. Click okay. Complete this process to unhide rows and unhide columns. 
• Verify that any unhidden information is responsive to the request. If not STOP and 

contact your supervisor. 
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Shortcut 

• You can complete the same process by right clicking on a worksheet tab ( at the bottom 
of the workbook) and choosing Unhide. 
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Calibri 

B I 

1±1 • 
Clipboard ., 

1 
2 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 
13 
14 
15 
16 
17 
18 
19 

C19 

A 8 

Insert Page layout formula!. 

. 11 . - - � 
-
!!ii' 

!! . A" A• - - -

• ,A. ·  ':F= t� �-
font r, Alignm�nt 

Ix 
C D E 

D ata Review View Add-Ins Acrobat 

G•n,ral . ""' Condrt1on,1 Formattln9 • �Q lnsut • l: • 
$ . % � Format as Table .,. ,I"' Delete • 

�,8 -� ® Format "' 
Sort & Find & 

Cell Styles • . FIiter • Select· 
Number r. Styles Cells Edrtmg 

-
F G H K M ... 
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2. Remove All Filters 

•rt Pago Layout Formulas Data R•vi•w V,ow Add-In< Acrobat 

• 11 • 

!,! • K A. 

General • iJj Conditional Formaittin9 .,.. 

iF :ii =11 $ • % Format as Tabl• • 
Paste ,::I . � .  i� f)!° ,1,9,r �08 .. , I � Coll SlylO< • 

9-a Insert ... 

El"' D•lot• • 

[J Format ... 
Chpboard_r. ____ _ Font ___ A_li-=-gn_m_ent ____ N_umbe� �es Cells ==--- ---==== 

A2 

A B C D E G H 
1 

2 .I 

3 17-32402 

4 17-38957 

5 17-42505 

6 17-42649 

• Before processing the Excel workbook in response to a FOIA it is important to ensure 
that all filters are cleared so all information in the cells are displayed. To do this, make 
sure to click on the Home menu on the top ribbon. 

• Click the Sort &Filter icon on the top right side of the screen then choose clear. 
• This will remove any filters previously applied to the workbook. 

Shortcut 

• You can expedite this process by hitting Alt+A+C on your keyboard which removes all 
filters . 
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3 .  Auto-Expand All Cel ls 
• Before processing the Excel workbook in response to a FOIA it is important to ensure 

that all cells are automatically expanded to reveal any potential hidden information 
contained within the spreadsheet. To do thls, make sure to click the Home menu on the 
top ribbon. 

• In the top ribbon click the Format menu/click AutoFit Row Height. 
• Click the Format menu in the top ribbon again/cl ick AutoFit Column Width. 

Home Insert Page Layout Formulas Data Review View Add-Ins Acrobat 

Calibri .... U ... � � iiiiiii � Ge:neral 

B I 1l • A A. ii= ... 'ii 
Paste ':/ '__j • e. . A . �i" �i" -,SJ,· 

Clipboard r.., 

G7 

A 
1 

2 
3 17-46429 
4 17-46362 
5 17-45820 
6 17-45739 
7 17-45668 
8 17-45409 
9 17-45407 
10 17-45406 
11 17-45247 
12 17-45241 
13 17-448TI 
14 17-43023 
15 17-42649 
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Microsoft® 

Excel 201 3 
Quick Reference Card 

Custom G u id e  
O n l i n e L e a r n i n g 

Free Cheat Sheets!  

Visit: cheatsheet.customguide.com 

The Excel 201 3 Screen Keyboard Shortcuts 

Quick Access Toolber 
I 

Title bar Formula Bar Close buHon 

I 
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File teb --- t-OM[ MUil P'1IU.l"JUI' f-Ofl.MLUS o.-u ID'[W .... rw •� r 

Name 
box 

__ 
., 

' 
10 

" ,, 
" " 
...JI 

� Ulllm •Ju • • = ii' i-JI • �UIM-11.._1'4' i" rmff • l: • jl' • 
11:!!i· 11 , 11. . �; ,.· _ :. .;  � - , • ,... , (;ir ........ T,blo• �:i.... • til· A ·  
ol �i • .a, . t::E C.,- ol ... , (ell�• •cwn" "  It.· 

Active cell 

Rows 
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I Worksheet labs 

....... 

Columns 

Scroll __ _ 
bars 

I 
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View buttons Zoom slider 

Ribbon 

The Fundamentals 

• The File lab menu and Backstage view contain commands 
for warlcing lMlh a program's files, such as Open, Save, 
Close, New, and Pnnl. 

• To Create a New Workbook: Click 
the File lab, select New, and 
double-1:lick workbook, or press 
<Ctrl> + <N>. 

• To Open a Workbook: Click the File 
tab and select Open, or press 
<Ctrl> + <O>. 

• To Save a Workbook: Click the El 
Save button on the Quick Access 
Taolbar, or press <Clr1> + <S>. 

• To Preview and Print a Workbook: 
Click the File tab and select Print, or 
press <Ctrt > + <P>. 

• To Undo: Click the ., • Undo 
button on the Quick Access Taolbar, 
or press <Clrl> + <l>. 

• To Redo or Repeal: Click the 
c" • Redo button on the Quick 
Access Toolbar, or press <Girt> + 
<Y>. 

• To Close a Workbook: Oick the 
• Close button, or press <Girt> 

+ <W>. 
• To Get Help: Press <F1 > to open 

the Help window. Type your question 
and press <Enter>. 

• Cell addresses: Cells are referenced by 
addresses made from their column letter 
and row number, such as cell A1, A2, B1, 
B2, etc. You can find the address of a cell 
by looking al the Name Box under the 
clipboard 

• To Select a Cell: aick a cell or use the 
keyboard arrow keys to select �. 

• To Select a Cell Range: Click and drag la 
select a range of cells. Or, press and hold 
down the <Shill> key while using the 
<arrow keys> to move the mouse 
pointer to the last cell of the range. 

• To Select an Entire Worksheet: Click the 
Select All button where column and 

row headings meet. Or press <Ctrl> + 
</>;>, 

• To Minimize the Ribbon: Click the • 
Minimize Ribbon button an the Ribbon. 
Or, press <Cli1> + <F1>. Or, right-1:lick a 
rab and select Unpin the Ribbon from the 
contextual menu. 

• To Change Program Settings: Gick the 
File lab and select Options. 

• To Use Zoom :  Click and drag the zoom 
slider ta the left or  right. Or, click the I 
Zoom Out and D Zoom In buttons on 
the slider. 

• To Change Views: Click a View button in 
the status bar. Or, click the View lab and 
select a view. 

General 
Open a Workbook <Ctrl> + <O> 
Create New <Ctrl> + <N> 
Save <Ctrl> + <S> 
Preview and Print <Ctrl> + <P> 
Close a Workbook <Ctrl> + <W> 
Help <F1 >  
R u n  Spelling Check <F7> 
Calculate worksheets <F9> 
Create an absolute, <F4> 
normal, or mixed reference 

Navigation: 
Move Betv.ieen Cells <t>, <.I.>, 

<+->, <-+> 
Right One Cell <Tab> 
Left One Cell <Shift> + <Tab> 
Down One Cell <Enter> 
Up One Cel l  <Sh ift>+ <Ente 
Down One Screen <Page Down> 
Up One Screen <Page Up> 
To Cell A1 <Ctrl> + <Home 
To Last Cell <Ctrl> + <End> 
Go To Dialog Box <F5> 

Editing 
Cut <Ctrl> + <X> 
Copy <Ctrl> + <C> 
Paste <Ctrl> + <V> 
Undo <Ctrl> + <Z> 
Redo <Ctrl> + <Y> 
Find <Ctrl> + <F> 
Replace <Ctrl> + <H> 
Select All <Ctrl> + <A> 
Ed� active ce 1 1  <F2> 
Clear cell contents <Delete> 

Formatting 
Bold <Ctrl> + < B> 
Italics <Ctrl> + <I> 
Underline <Ctrl> + < U> 
Open Format Cells <Ctrl> + <Shift> 
Dialog Box + <F> 
Select All <Ctrl> + <A> 
Select entire row <Shift>+<Space> 
Select entire column <Ctrl> + <Space> 
Hide selected rows <Ctrl> + <9> 

Hide selected <Ctrl> + <O> 
columns 

C u stom - U j de  _1n_te_ra_ct_i_11e_o_nl_in_e_L_ea_r_n_in=g __________ _ 
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Ed iti ng Formatting 

• To Edit a Cell's Contents: Select the cell and click the Fonnula Bar, or 
double-click the cell. Edit the cell contents and press <Enter>. 

• To Clear a Cell's Contents: Select the cell(s) and press the <Delete> key. 

• To Cut or Copy Data: Select cell(s) and click the Cut or li'Jill Copy button 
in the Qipboard group on the Home lab. 

• To Paste Data: Flace the insertion point \lohere you want to paste and click 

the •• -! Paste button in the Qipboard group on lhe Home lab. 
• To Preview an Item Before Pasting: Place the insertion point \loherc you 

want to paste, click the Paste button list arrow in the Clipboard group on the 
Home lab, and hold lhe mouse over the paste option to preview. 

• To Paste Special: Select the destination cell(s), click the Paste button list 
arrow in the Clipboard group on the Home tab, and select Paste Special. 
Select an option and c Ii ck OK. 

• To Copy Using Auto Fill: Point to the fill handle at tho bottom-right corner of 
the selected cell(s), then drag lo the destination cell(s). 

• To Complete a Series Using Autofill: Select the cells that define the series. 
Click and drag the fill handle to complete the series. 

• To Move or Copy Cells Using Drag and Drop :  Select the cell(s) you want to 
move or copy, position the pointer over any border oflhe selected cell(s), then 
drag to the destination cells. To copy, hold down <Ctrt> key while dragging. 

• To Insert a Column or Row: Right-click to the light of the column, or below 
the row you want to insert. Select Insert from the contextual menu, or click the 
Insert button in the Cells group on the Home tab. 

• To Delete a Column or Row: Select the row or column heading(s). Right­
click and select Delete firom the contextual menu, or click the Delete button 
in the Cens group on the Home tab. 

• To Insert a Comment: Select the cell where you want to insert a comment 
and click the Review tab on the Ribbon. Click the New Comment button in 
the Comments group. Type a comment and click mdside the comment box. 

Formu las and Fu nctions 

• To Total a Cell Range: aick the cell where you want to insert the total and 
click the Sum button in the Editing group on the Home lab. Verify the 
selected cell range and click the Sum button again. 

• To Enter a Fonnula: Select the cell where you want to insert the fmmula. 
Type = and enter the formula using values, cell references, operators, and 
functions. Press <Enter> when you're finished. 

• To Insert a Function: Select the cell where you want to enter the function 
and click the r. Insert Function button on the Formula Bar. 

• To Reference a Cell in a Fonnula: Type the cell reference (for example, BS) 
in the formula or click the cell you want to reference. 

• To Create an Absolute Cell Relerence: Precede the cen references with a $  
sign or press <F4> after selecting coll(s ) to make I absolldo. 

• To Use Several Operators or Cell Ranges: Enclose the part of a formula 
you want to calculate fifsl in parentheses. 

Charts 

• To Create a Chart: Select the cell range that contains the data you wanl to 
chart and click the Insert lab on the Ribbon. Click a chart type button in the 
Charts group and select the chart you want to use from the list. 

• To Insert a Sparkline: Select the cell range that contains the data you want 
to chart and click the Insert tab on the Ribbon. Select lhe spandine you want 
to insert from the Sparkline group. Select the cell or cell range where you want 
to add the spark line and ctick OK. 

Custom u I d e  Interactive Online Learning 

• To Fonnat Text: Use the commands in the Font group on the Home tab, or 
click the Dialog Box Launcher in the Font group lo open the dialog box .. 

• To Fonnal Values: Use the commands in the Number group on the Home 
tab, or click the r, Dialog Box Launcher in the Number group to open the 
F annal Ce Os di al og box. 

• To Copy Fonnatting with the Fonnat Painter: Select the cell(s) with the 
formatting you want to copy and click the " Fonnat Painter button in the 
Cr.pboard group on the Home tab. Then, select the cell(s) you want to apply 
the copied formatting to. 

• To Apply a Cell Style: Select the cell(s) you want to apply a cell style to. 
Click the Cell Styles button in the Styles group of the Home tab on the 
Ribbon and select a style from the gallery. 

• To Fonnat a Cell Range as a Table: Select the cells you want to apply table 
formatting to. Click the Fonnat as Table button in the Styles group of the 
Home tab on the Ribbon and select a table fonnat from the gallery. 

• To Apply a Document Theme: Click the Page Layout tab on the Ribbon, 
click the Themes button in the Themes group, and select a theme from the 
gallery. 

• To Apply Conditional Fonnatting: Select the cells lo v.11ich you want to 
apply conditional formatting. Qick the Conditional Fonnattlng button in the 
Styles group of the Home tab. Select the formatting scheme you wsh to use, 
then set the conditions in the dialog box. 

• To Adjust Column Width or Row Height: Drag the right border of the 
column header, or the bottom border of the row header. Double-dick the 
border to AutoFit the column or row according to its contents. 

Wor kbook Management 
• To Insert a New Worksheet: Qick the • Insert Worksheet button next to 

the sheet tabs at the bottom of the program screen. Or, press <Shift> + 
<F11>. 

• To Delete a Worksheet: Select the sheet want to delete, click the Delete 
button in the Cells group on the Home tab, and select Delete Sheet. Or, 
righl-dck the sheet tab and select Delete from the contextual menu. 

• To Rename a Worksheet: Double-cl ick the sheet tab, enter a new name for 
the worksheet, and press <Enter>. 

• To Change a Worksheet's Tab Color: Right-er.ck the sheet tab, select Tab 
Color, and choose the color you want to apply. 

• To Move or Copy a Worksheet: Oick and drag a tab to mo�e a worksheet. 
Hold down the <Ctrt> key while clicking and dragging to copy the v,,:,rksheet. 

• To Split a Window: aick tho View tab and click the Split button in the 
Window group. Or, press <Alt> + WS (one at a time]. 

• To Freeze Panes: Place the cell pointer where you want to freeze the 
window, er.ck the View tab on the Ribbon, click the Freeze Panes button in 
the Window group, and select an op�on from the list. 

• To Select a Print Area: Select the cell range you want to print, click the Page 
Layout tab on the Ribbon, click the Print Area button in the Page Setup 
group, and select Set Print Area .  

• To  Adjust Page Margins, Orientation, Size, and Breaks: Click the Page 
Layout tab on the Ribbon and use the commands in the Page Setup group, 
or click the r. Dialog Box Launcher in the Page Setup group to open the 
Page Setup dialog box. 

• To Protect or Share a Workbook: Click the Review tab on the Ribbon and 
use the comm ands in the Changes group. 

• To Recover Autosaved Versions: Click the File tab on the Ribbon and 
select Info. Select an autosaved version from the Versions list. Or, click the 
Manage Versions button and select Recover Unsaved Workbooks. 
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Microsoft Excel Delivery Prep 

1 .  Delete Al l  Metadata 

me Insert Page Layout formulas Da a Rrnew View Add-Im Acrobat 

Sa¥e as Adobe PDF 

Recent 

New 

Print 

Save & Send 

Help 

[1l Options 

i3 Exit 

Information about Bookl 

Protect 

1 Workbook • J 

Check for 
Issues ·  

Permissions 
Anyone can open, copy, and change any part of this workbook. 

Prepare for Sharing 
Beforo sharing this Iii,. be aware that it contains: 

Document properties and author's name 

Versions 
:!i:) There are no previous versions of this file. 

Prop,rti,s • 

Silt 

Trtle 
Tags 
Categones 

R,lattd Dotts 

Last Modif1td 
Crtated 
L•st Pnn!td 

tlot ,av,d y,t 
" d a 1, 
1.1:SA 
ERO 

I ,ver 
Today. 2:49 PM 
t ,ver 

- d al hor 

Last Mod1f1ed By I ,t , ed ,t 

Show All Properties 

• Click the File tab in the top ribbon then ensure that the Info menu is displayed. 
• Under the Properties section on the right side of the screen delete as much of the 

metadata as possible. 
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2. Password Protect Entire Workbook 
me lnsert Page layout Formulas Data 

Information about Bookl 
Save A5 

View A<td-lns Acrobal 

nyone can open. copy, and change any part of this workbook. 

New 

Print 

Save & Send 

Help 

S Optiom 

i:il lxit 

Require a Jlil55word to open this 

.e_rotffl Currfflt Sheet 

Prolttl �Orkbook Shucture 
Prevent unwanttd clu1nges to tne structurt 
or lhe wortt:ioot, suc.r, a! adding sneeu. 

Restrict Pennis�n by Peopl� 
Grant peoptt .!lccus while remoiting lhtir 

abil ity to l!di copy, or print. 

Add a Digital �g�ture 
Enture the inte!1rity of the workbook by 
addir,g an in..,i51ble digital 5 ignature. 

tt contains: 
r's name 

f th1s.fil� 

Properties .,.. 

Sl:zt 
Title 
Tags 
Caltgontl 

Related Dates 

Lan Modified 

Created 
La.st Prlntt:d 

Related Peo pie 
Autt,or 

Last Modified By 

Show All Properties 

• Click the File tab in the top ribbon then ensure that the Info menu is displayed. 

riot HI edyd 

t.dd a ut e 
Add a '"ag 
Add a category 

Nt tt 

Today. 2 49 PM 
� e er 

Kb)(6);(b)(7)(C) 
.. dd ar author 

r 01 sa,.cd d 

• Next click the Protect Workbook icon in the middle of the screen then select Protect 
Current Sheet . 

Review i liij color< · 
� � I] El � I IA] Font, · ·� 

The
T
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� Effect� ,.  
Margim Orientation Size Print Brtals Bad'.ground Print 

Area " Titles 
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t.,U.,Js, 

A C 0 G 
19 

20 
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22 
23 
24 
25 
26 
27 
28 
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30 
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• A pop up w indow appears . Ensure that only the top two boxes are checked under Allow 
users of this worksheet to: 

• Also enter a pass\vord (containing 3 random numerical characters, 3 letters, then 3 
random numerical characters) and click OK 

• You ,viU be prompted to re-enter your passv,,rord then click OK. 
• Repeat process for EACH (indicated by the tabs at the bottom of the 

workbook) contained within the workbook. 
• Save a new copy of the Excel \vorkbook 
• Verify that changes cannot be made. 
• DO NOT deliver the password to the requester. Individuals with access to the password 

have the abil ity to rem.ove the ,vorkbook's protection. 

3. Updating FOIAXpress 
• Type the passv./ord used to protect the workbook in  the comments section in 

FOIAXpress. 
• Load a copy of the redacted and fully protected workbook into the FOIAXpress 

correspondence 

1 1 /20117 

Page 49 of  1 29 

35 

all 

this 'Norksheet 

log. 



High Profile Request Process 

1 .  Initial High Profile Notification� I ntake Team 
l .  l .  Al l  requests meeting the high profile criteria must ha-ve a high profil e  notification e-mail 

sent before tasking the program office for a search to be conducted for records. 
Determining if a case is h igh profile is based upon whom the requestor is or on the 
subject matter of the request To send the notification through FOIAXpress, select 
Correspondence/Send Correspondence/click the dropdown menu next to Template/under 
Email Options select the ICE High Profile Notification template. 

1 .2 .  Open Outlook. Create a new message. Copy and paste the text from the e-mail template 
in FOIAXpress into the body of the Outlook message. Ensure there are no spell ing 
mistakes. Attach a copy of the request. Copy and paste the e-mail addresses l isted in the 
template. Send the e-mail. 

1 .3 .  Once the e-mail is sent, add the notification to the FOIAXpress correspondence log. 

C lick Correspondence/ Receive Correspondence/ enter High Profile Notification in the 
Subject box/ drag and drop the e-mail that was sent from Outlook to the Drag and Drop 
Zone in FOIAXpress. Click Save. 

1 .4 .  You may now proceed with tasking the request to the program offices responsible for 
conducting the search. 

2. High Profile Clearance Process� Processing Team/SuperYisors 
2 . 1 .  When the records have been processed and reviewed by your Supervisor, high profile 

cases must be c leared prior to release. (All high profile program level clearances are 
done Supervisor/Analyst level, and the clearance approval \Vi l l  be provided to the 
Deputy FOIA Officer and FOIA Officer). Detem1ining if a case is high profile can be 
based upon whom the requestor is or on the subject matter of the request. I'.)1Jically, the 
intake team ivill send a high prc�file notification 1,vhen the request is received which is 
located in the corre.\JJondence log; hm1lever, a request can becorne high profile £�fter the 
intake process has occurred based on content of the records. Do not assume that a 
request does not need high pn�file clearance based on the niarkings on the folder or ifa 
high profile not(fication ivas not initially sent by the intake tea,n. 

2.2. The S upervisor or Analyst i s  to create a c1earance e-mail i n  Outlook for all high profile 
cases, regardless of the information that is being released. The notification will be sent to 
the Deputy FOIA Officer and the Deputy FOIA Officer will review all high profile 
requests (the expectation is that all problems/issues with the case have been resolved 
prior to the FOIA Officer receiving it) . The e-mail should state: 

1 1/20117 

ICE will release to REQUESTOR NAME, a representative with 
REQUESTOR ORGANIZATION, TOTAL # OF PAGES of records 
pertaining BRIEF DESCRIPTION OF THE REQUEST. Portions of the 
release will be withheld pursuant to exemptions LIST EXEMPTIONS of 
the Freedom of Infonnation Act [ICE FOIA Case Number CASE 
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NUMBER] 

A copy of ICE '  s response may be accessed here. 

If the request contains con-espondence (emai ls, calendar documents, etc .) of ICE 
leadership (specifically, the D irector, COS, Deputy Director, EADs, OPLA or other 
DHS leadership), and it is determined that the request requires Front Office 
clearance, include the requ ired language in the template l isted in Appendix A. 

2.3. Before sending the clearance e-mail, create a folder on the S drive under the OAS fol der 
titled the request number. Add a copy of the request, redacted records, and a copy of the 
proposed final response letter. Create a hyperlink on the word "here" in the Outlook 
clearance e-mail pointing to this folder on the S drive. 

2.4. Send the E-mail to the Deputy FOIA Officer, who will rev iew the records. Upload a 
copy of the high profile c learance e-mail to the con-espondence log of the request After 
the Deputy FOIA Officer reviews the records, the Deputy FOIA Officer will fon�nrrd the 
notification to the FOIA Officer, regardless of the sensitivity or s ignificance of the 
infonnation that is being released, who will obtain agency level clearance. The FOIA 
Officer may c lear the request with an SES level staff member of those offices containing 
equity in the request and/or from OPLA, i f  needed, and will forward the clearance 
package to the Office of Publ ic Affairs and the Office of Congressional Relations for 
awareness . Once c leared by all interested parties the FOIA Officer will send the 
notification to the Assistant Director, IGP who may forward it to the M&A EAD front 
office for awareness . Once clearance is granted by all parties, the FOIA Officer notifies 
the Supervisor/Deputy FOIA Officer when he/she may move forward with the DHS l 
Day Notification process and will send the supervisor al l  clearance responses for loading 
to the correspondence log. 

2.5. The DHS l Day Notification process i s  used to notify DHS pol itical appointees, OPA, 
OLA, OGC and key l eadership from the DHS Secretary's  Office of possible impending 
media inquiries or l itigation related to the release of i nfom1ation. This process is used as 
a notification vehicle only and significantly does not allow for political appointees to 
approve, modify, or delay significant releases (see a detailed description from the 

Deputy Chief FOJA Officer in Appendix B). When sending the DHS 1 Day Notification 
an e-mail 10 l(b)(6) ; (b)(7)(C) I an e-mail should be drafted in a 
specific format to include the requester ' s  name, organization, a brief description of what 
was requested, and what infonnation is being withheld under which FOIA exemptions 
(see an example  in Appendix C). 

2 .6 .  In the event a 1 Day Notification e-mail is sent after 4PM the processor must wait 48 
hours before delivery to the requester. The After the DHS l Day Notification period has 
expired the FOIA analyst can deli'ver the records. This must be one ful l  day before the 
document can be delivered to the requester. 
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Appendix A (Example): 

Overvie'w:  This release contains records from 201 6  while the presidential campaigns were 
underway. The materials are l imited to emails, copies of news articles and the agency news 
c l ips, and one set of oversight hearing prep materials. Most emails are brief and concern public 
affairs or congressional affairs matters that triggered internal follow-up action. While there are 
emails to and from the former D L  D2, and other senior officials at ICE (and a few with senior 
level OHS officials), what is being released does not appear significant or controversial. There 
are also 1 00+ pages of the release which are simply news stories and copies of the Clips. There 
are also copies of several congressional letters and our responses regarding immigration issues. 

Action Requested: Please notify me by noon tomoITow if you have any concerns or questions 
about the release . We will send this to DHS FOIA tomorrow for their one-day revie\v period and 
then release. 

FOIA Request Description :  Bobby Smith, a representative with the Law Firm of Smith and 
Smith in Washington, DC, requested records related to any and all communications, including 
but not limited to emails, sent to and from John Doe (Executive Director) and Jane Doe 
(Associate Director) and Paul Doe (Director) , mentioning or referring to "Trump", "Grassley", 
"Republicans", "GOP", "Judiciary", "Sessions", and "Breitbart." 

Response: Portions of the 406 pages will be \Vithheld pursuant to FOIA Exemptions (b )(5), 
(b)(6), (b)(7)(C) and (b)(7)(e) . Some pages are also withheld as duplicate copies. 

Of potential interest: 

• P. 1 - Email from John Doe to Jane Doe, with chain including HSI senior staff regarding 
the Southwest Border, and readouts on D l trip to Mexico and Central 
America. Comment re how the pol itical election rhetoric is causing a pull of m igrants 
into the US.  

• P. 1 29, 1 32 ,  1 3 3  - John Doe emails with various executives re media inquiries re alien 
who threatened POTUS and making D 1 aware. Contains ES for the alien. 

Ref: ICE FOIA Case Number 201 7-ICFO- 1 23456 

1 1 /20117 
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Appendix B- DHS 1 Day Notification Process 

ALCON, 

Gentle reminder concerning the Department's internal c learance process for incoming FOIA 
requests and release of records that involve complex, issues of publ ic/media i nterest, or White 
House equities . These processes w·ere put in place in order to ensure the appropriate stakeholders 
in the Front Office, the Offices of Public Affairs (OPA), Legislative Affairs (OLA), and General 
Counsel (OGC) have visibili ty and situational awareness of releases wil l  potentially generate 
interest (internal and external). Both processes are managed by the DHS Privacy Office FOIA 
Team in coordination with the component FOIA Officers and OGC. The procedures were 
developed over time to ensure that the Department \Vas in a position to respond appropriately to 
materials released under FOIA, while ensuring that the release detennination was free from 
improper influence. As you may recall, improper interference has been an issue for the 
Department previously, and these procedures \Vere designed to guard against allegations of such 
interference.  

One-Day Awareness Notification Process: 

The one�day notification process is used to notify political appointees, OPA,  OLA, OGC and key 
leadership from the DHS Secretary's Office of possible impending media inquiries or l itigation 
related to the release of information. This process is used as a notification vehicle only and 
significantly does not allow for political appointees to approve, modify, or delay s ignificant 
FOIA releases. 

The One-Day notification process includes a high-level summary of the request and records that 
,viii be released, to include the date of release. A l ink to a SharePoint site is provided withi n  the 
body of the email .  This s ite contains pdf copies of the incoming FOIA request; records that wil l  
be released (redactions appli ed); and final response letter. The notification email is sent 24-hours 
prior to the planned date of release in order to al low for suffic ient not ification. Senior DHS 
Privacy Office staff (i .e. ,  l eadership) also have access to faci litate. 

The DHS Privacy Office is drafting fonnal instructions that wil l  describe and define the one-day 
notification process. Prior to final izing, the draft instructions will be routed through the 
Component FOIA offices for review and comment. The goal is to have the instructions finalized 
and issued no later than FY1 8Q3. 

White House Equities: 
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Kb)(6); (b)(7)(C) I By memorandum dated February 20 1 7, Acting General Couns��------��1utlined 
the requirement that all Depmtment officials must consult ,vith the \Vhite House Counsel' s  
Office on all document requests that may involve White House equities including: 

• Congressional committee requests; 
• GAO requests; 
• Judicial subpoenas; and 
• FOIA requests. 

Any consultation with the White House Counsel 's  Office be coordinated by the DHS 
Privacy and the DHS OGC. In March 201 7  the OHS Deputy Chief FOIA Officer sent a 
reminder to the Component f ................... .........i' kers of the requirements outl ined in the memorandum 
from Acting General Counsel nd provided instructions on how to initiate the 
consultation process with the DHS Privacy Office. These procedures are the same as procedures 
fol1owed previously, per the request White House Counsel . 

Please feel free to contact me if  you would like to discuss in more detail . Thank you. 

Regards, b )(6) ; (b )(7)(C) 
�b )(6); (b )(7)(C) 

Deputy Chief FOIA Officer 
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Appendix C- DHS 1 Day Notification Sample 

On August 1 0, 20 1 U.S. Immigration and Customs Enforcement (ICE) wil l  released to 
(Requester Name), a representative from the (Requester Orga11izati01i), in Crown Point, 
Indiana, three pages records pertaining to (inse1t a brief description of the records being 
released). Portions (3) pages wil1 be ,vithheld pursuant to Exemptions 5 ,  6, 7 (C), and 7(E) 
the Freedom of Infom1ation Act. (Case Number JCE 201 8-ICFO-XXXXX) 

The release has been uploaded into 

(Include a hyperlink on the word SharePoint to the DHS SharePoint folder where the records for 
review have been placed. )  
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SEGREGABILITY = RELEASE ALL NON-EXKMPT INFORMATION 

L Presumption i n  favor of release; openness prevails 
2. Foreseeable Hann-Release WOULD cause harm 
3 .  Any reasonably segregable portion shall be  provided (DO NOT B LANKET REDACT) 

Ensure that the documents you are reviewing match exactly the FOIA request, first and last name and DOB, 
to avoid a privacy breach. Consult a supervisor if  necessary 

A RELEASE TO ONE IS A RELEASE TO ALL 

EXEMPTION 3 • N O  FLY-found on TECS Report 
(b )(3), (b )(7)( e) • TIDE- refers to teJTorist watch/no fly list, found 

remarks on TECS report 
Protects information that Congress has specifically • 49 U.S.C. § 1 14(r) Transportation Security 

exempted from disclosure Administration • 18  U.S.C. § 3509(d) (Federal Victims' 
Most often, Protection and Rights Act) : Certain records 

49 U.S.C. § 1 l4(r) containing identifying information pertaining to 
Transportation Security Administration :  Exempts children involved in criminal proceedings 
Sensitive Security Information (SSI) the disclosure of • 3 1  U.S.C. § 531 9  (Bank Secrecy Act): Look for 

which would be detrimental to security of "Financials" in TECS records 
transportation • See also list of statutes published by DOJ: 

httg://,,,rvvw. justice. gov/oi12/exemi;2tion3 .gdf 

EXEMPTION S • Includes some memorandums/emails betvveen 
(b)(5) DHS attorneys where "I believe", "I recommend", 

"my opinion" are stated to suggest a course of 
Protects action or policy 

l .  Deliberative Communications • Attorney vVorksheets/Attorney >Jv'ork-Product 
2. Attorney '\\1 ork-Product* • GEMS Attorney Report 
3. Attorney-Client Communications • TA (Trial Attorney) Worksheet 

• Attorney Notes (READ NOTES FOR CONTENT 
Usually documents are segregable TO RELEASE) factual information within 

***Just because the form says "Attorney ,vork 
immigration notes are releasable • Used ,vhen a government attorney makes a note 

Product" or "FOIA Do Not Release" does not that discusses strategy of a case- what the 
necessarily indicate that this exemption applies attorney plans on doing, opposing, other case 
to the document. READ CAREFULLY!*** strategy that might apply 

• May also be used on asylum hearing notes (often 
hand,:vri tten) 

• May include attorney work products such as 
handvlritten notes, drafts of briefs, copies of 
Westlm;,,1 pages, other cases, or anything used to 
prepare for a case 
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EXEMPTION 7(e) 
(b)(7)(e) 

• Computer soft keys PF7, F l=Help) 
• Database codes on header and footer of DACS 

Protects sensitive Law E nforcement techniques and • 
procedures 

reports (e.g., CLOS, EOIR) 
Codes on header ofTECS reports 
TID 

T2MRGO, 

1 1 120/17 

• URLs to Federal government law enforcement 
databases 
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EXEMPTION 6 
(b)(6), (b)(7)(c) 

PERSONALLY IDENTIFIABLE 
INFORMATION (PU) 

PII is information that is personal i n  nature and \Vhich 
can be used on its own, or with other information, to 

identify an individual. 

INFO PERTAINING TO THIRD PARTY 

Includes Law Enforcement personnel, government 
attorneys, family members, and some information 

about the subject 
(See also RULE of NAMES section) 

NOTE: On 1-213 form onh1, ok to re]ease name of 
deceased mother/father 

1 1 120117 

ALL THIRD PARTY PERSONALLY 
IDENTIFIABLE INFORMATION (PII) 
• Names and initials 
• A-Numbers 
• Street address, be sure to include Suite F loor 

or Building # if part of address 
• Date of Birth (DOB) 
• The entire Social Security number 
• Phone nun1bers (withhold last 4 digits) and any 

extensions 
• Email addresses 
• Work information 
• Government-issued IDs (e.g., Driver's l icense, 

passport numbers, car VIN number, car l icense 
plates) 

• Photos or fingerprints of third party 
• Receipt numbers from USCIS applications and 

petitions (ex. Staiis \\rith WAC, SRC, MSC, or 
LIN) 

• Bond Number/Bond Receipt Number/Bond 
Breach Number/Power of Attorney Number­
only  when held by a third party (this would be a 

member or friend usually) 
• Any private party that bonds out individuals 

should be released but their social security 
numbers ma)' be withheld 

• Any individual signing for a FOD or SAC 

LAW ENFORCEMENT/THIRD PARTY PH 
• Suite numbers, room numbers, and floors of all 

DHS addresses and all DHS phone numbers and 
extensions that are not public 

• Badge number, star number, shield number oflaw 
enforcement officer and canine officer badge 
numbers 

• Code login identifiers 
• Law Enforcement-assigned numbers assigned to 

third pa1iy 
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EXEl\·IPTION 7 
(b)(7)(E) 

RELATES TO LAW ENFORCEMENT 
CODES AND PROCEDURES 

• FBI Number-ALWAYS redact entire field 
with heading, even if blank) 

• Federal ORI Codes- begins with state 
abbreviation follm,ved by 3-letter agency code and 
then a 4-digit  number ( ex. WVFBIO00 1 ); state and 
local ORI codes are releasable 

rb)(7)(E) 

1 

• Fingerprint Reports: Redact Fingerprint 
scores/Fingerprint pattern codes/Database (Sys) 
used; also Status remarks if they refer to a match, 
no hit found, A-number, or event number. The 

L.,_ __________________ ___. actual finger print should be released. Read 

Also withhold as law enforcement information : 
• S-Visa/Form 1-85�-given to alien providing 

information/acting as confidential 
i nformant/\:vitness. 

• T-Visa/Forms 1-914, 1-914 Supplement A-,,-­
immigration protection for victims of human 
trafficking; also T- l nonimmigrant status 

• U-Visa/Forms 1-918, 1-929--immigration 
protection for cooperating victin1s of certain 
cnmes 

1 1 /20/17 

carefully! 
• Any DHS or Law Enforcement system checks that 

are nm and results of those checks (b)(l)(El 
b)(7)(E) 

• Detainee Classification System/Escort Threat 
Assessment/Background check 

• Case Number (Federal level only, not state or 
local) 

• Event Number (the Encounter Number/ EID/ and 
External System ID should be released) 

• Person ID (but NOT Subject ID) 
• Operation names (e.g., Operation Janus) 
• l(b)(7l(El �redact body of the 

report depending on information, read carefully 
• Request ID # on any query reports 
• FDU Referral Number- Fraud Detection Unit  
• BFU Number-Benefit Fraud Unit 
• Mention of Special Interest Country ( e.g., Iran) 
• "US-Visit Watch lnfonnation Exists" or any 

Lookout reference 
• fb)(7)(E) 

withhold title and segre
]

ate repmt as necessa
.
· ry 

• fbl(7l(El _ WIF using k2, b7E 
• Interpol Worksheets- WIF 
• l(b)(7)(E) [see also 

TERRORISM) 
• A TS-P-Automated Targeting System-Passengers 

(database) 
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TERRORISI\l 
(b){7){e) 

• JTTF (Joint Terrorism Task Force) 
• (b)(7)(E) 

l.-----------------------1 • (b)(7)(E) 

Refer to Supervisor with any q uestions 

FINANCIAL 
(b)(3), (b)(7)(e) 

\Vithhold all mentions of law enforcement financial 
checks 

see also Exemption 3 section 

FUGITIVE 

Fugitives, under the INA, do not have a right of 
access to records through a FOIA request. 

Fugitive checks should only be done on requests 
that a re submi tted directly submitted to ICE and 
·where ERO is  required to conduct  a search for 
records. 

1 1 120/17 

• 

(b)(7)(E) 

• FINANCIALS on TECS Report­
withhold/segregate from text as necessary 

o refer to ICE if  specific operation or 
investigation is mentioned or ongoing 

• 3 1  U.S.C. § 5319 (Bank Secrecy Act): Look for 
"Financials" i n  TECS records 

• If you see FIN CEN records, immediately stop 
processing and refer to your Supervisor. 

• Currency Transaction Reports (CRT), cun-ency 
Monetary Instrument Reports (CMIR) and other 
Bank Secrecy Act information 

• HIFCA = H igh Intensity Financial Crirnes Area 
• FUGITIVE 
• Fugith'e Operations or FUG OPS 
• Outstanding warrant for deportation 
• ABSCONDER or ABS 
• NO SH0\\1 for deportation/removal 
• FAILURE TO SURRENDER or FTS 
• FAIL URE TO APPEAR or FT A-fai lure to 

appear for court proceedings does NOT necessarily  

46 

Page 6D of 129 



*Please note that fugitiYe checks should not be  
conducted on USCIS  referral tases. 

1 1120117 

indicate fugitive status. Failure to appear to 
deportation/removal MIGHT indicate fugitive 
status 

• Referral to l,ESC as an Absconder 
• NCIC U nit \Vorksheets as Absconder 
• Case Category SB-Fugitive 
• Case Category SB-ICE Fugitive 
• Bond Breached 
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OK TO RELEASE 

In general, 
• release the subject's own information (PH) to 

him or his attorney of record 

• release state and local law enforcement codes 
and information 

• release business names, addresses, phone 
numbers; letterhead-protect people, not 
companies 

• something published or previously released to 
the public (i.e., news articles, press releases, 
published government memorandums, public 
websites) 

1 1 120117 

• Subject' s  address and phone number (current or 
fonner) as long as clearly associated with subject. 
If same address associated with third party, 
then withhold 

• Ok to release names, addresses, phone numbers, 
emails, and letterhead infonnation for any attorney 
who represented subject. 

• Subj ect's own F IN or FINS number 
• Alien's ovvn medical records and medical 

professional names/initials signing them. Law 
enforcement officer names within these records 
are to be ,,vithheld. 

• EOIR court room numbers 
• NCIC offense codes 
• Purpose Code on TECS reports 
• DACS Number/NAILS Number/NIC Number 
• Case Category/NCIC level/Classification 
• Method of Apprehension/G-23 code 
• SEVIS number and School ID 
• Category Level 
• IDENT number 
• Sections of law 
• Fax numbers; toll-free numbers 
• Acronyms for government agencies 
• State ID numbers/ C II number 
• State and Local ORI numbers 
• State and Local l aw enforcement codes 
• Business name, address, and phone 

number/Letterhead 
• Correction facility/deportation faci lity name and 

address 
• Booking number/ Prisoner number 
• Bond Number IF bond held by SUBJECT of the 

FOIA request 
• Lopez-Mendoza vs. INS-cited at interrogations 

and questioning 
• CIMMDA and EARM-MIG 
• CAP or 287g program 
• Secure Communities or SC program and PEP. 
• Law cases used as reference, anything already 

published 
• Name of Notary Public (See RULE of NAMES) 
• Business Taxpayer ID Number or EIN Number 
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• Subject's HIV Status EXCEPT ,vhen in  custody 
(per Bureau of Prisons) 

• Bond Obligor's Tax ID if it 's a business number 

IMPORTANT NOTES 
• Any investigative memos from ICE to another agency (usually USCIS) are NEVER, EVER included 

in the document. Extract those pages as nonresponsive to the FOIA request. 

• Travel information/flight number/ticket information for agents escorting an alien-withhold in full 
(\VIF) the entire page using b6, b7C, b7E. 

• ICE may only process ICE records-see Supervisor for referring non-agency records to the 
appropriate agency. 

• Make sure to line out all FOUO and LES markings on FOIA releases. Please set your FOIAXpress 
settings to RED ,11;1idth 3 for lines in the preferences section. If you require assistance please see your 
supervisor. b)(?)(E) 

THE RULE OF NAMES 
In  general, all third party names/initials and all Law Enforcement names/initials are withheld. 
This always includes: 

• Living Family members-parents, children, spouses, sibl ings 
• Other aliens 
• Acting Director, Interim District Director, Assistant Field Office D irector (AFOD), or Assistant Special 

Agent i n  Charge (ASAC) 
• Special Agents (SA)/Deportation Officers(DO)/Irnrnigrntion Enforcement Agents (IEA) and their shield 

numbers 
• Investigators 
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• Border Patrol agents 
• Translators 
• Employees 
• Government attorneys, assistant chief counsel (ACC), 

Releasable Names include 

attorneys (TA), general counsel 

• Public officials-if elected or appointed position (i .e. , mayor, senator, US Attorney General) 
• DHS officials~•· ·District Director, Field Office Director (FOD}, Special Agent in Charge (SAC) 
• Immigration Judge (IJ) and Chief Counsel (CC) 
• Notary Public 
• Medical professionals (found on the subject's medical forn1s only)-doctors, nurses, physician 

assistants, medical techs \vim provide care/meds or s ign medical fonns 
• Attorney of Record or any attorney who represents or represented the alien 
• Any names listed as part a firm's letterhead i s  considered "public" 
• Consuls/Consular of a foreign country, Attaches 
• ,varden 
• Individuals named on the ICE public organizational chart (see http:/h,vw,v. ice.gov/about/leadership/) 
• County C lerk 
• Bond Obligor 
• Deceased individual ' s  names 

Other Name Rules 
• Obvious m isspelling of a letter or two-ok to release 
• Phonetic spelling (sounds alike but spelling different)-ok to release 
• Names changed to their Engli sh equivalent ( ie . ,  Miguel to Michael, Jorge to George)--ok to release 
• Some cultures use 2 last names, either hyphenated or not, that may include .. .,u .. ,,,,." and mothers last 

names. Use the alien's name as provided on the G-639 for input. On documents, if you can confirm that 
any of the names used on the documents, regardless of order or variation, co1Tespond ,,1ith the surnames 
of the father, mother, or spouse provided on G-639, then name may be released. Also OK to 
check I-2 1 3  in case documents for family surnames used by the subject. 

• Middle names are releasable, even if not provided on the FOIA request. 
• If the alien provided an alias on the G-639, that name is  releasable. 
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Posting to the FOIA Reading Room/Library SOP 

I. Purpose / Application of SOP 

This  SOP provides internal ICE guidance regarding the process of posting records online to the 
public facing FOIA Library, also knmvn as the FOIA reading room, located at 
www.ice.gov/foia/library. 

Critical to ensuring the Department of Homeland Security (OHS)  successfully meets the 
President's  standards is compliance with the transparency outl ine by 5 U.S.C. § 552(a)(2) of the 
FOIA Under subsection (a)(2), federal agencies must make four distinct catego1ies 1 of records 
affirmatively available for publi c  i nspection and copying. In the DHS Chief FOIA Officer 's  
Proactive Disclosure and Departmental Compliance v.,1ith Subsection (a)(2) of the Freedom of 
Information Act (FOIA) memo (see Attachnumt A), the Chief FOIA Officer directs the 
Department and its components to include the foHowing categories of records on agency 
websites and l ink them to their respective electronic reading rooms: Historical dai ly schedules 
for most senior agency officials; Executed contracts & grants; Management directives and 
instructions; Congressional correspondence under OHS control ; FOIA Logs; Any records 
released pursuant to a FOIA request that have been, or l ikely to become, the subject of three or 
more requests. 

The Chief FOIA Officer further states, nothing in the memorandum was intended to l imit 
components ' abil ity to proactively post additional records beyond those suggested consistent 
v,1ith FOIA and other disclosure laws. A component may choose to post documents specific to its 
function in order to further advance transparency. 

The ICE FOIA office has developed two processes to handle these requirements. The first for 
records released pursuant to a FOIA request that have been, or are likely to become, the subject 
of three or more requests. The second, also known as proactive disclosures, to handle additional 
records the agency determines should be posted specific to its function in order to further 
advance transparency. 

II. FOIA Releases Subject to Additional Request for Posting 

The FOIA processing staff wi l l  provide the designated FOIA employee responsible for posting 
documents to the ICE FOIA Library with the request number and a copy, or physical location of, 
records subject to additional requests for posting to the ICE FOIA Library. The designated FOIA 
employee w ill hold on to this notification for 30 business days before performing any fmther 
action. After the 30 day period the designated FOIA employee \1i'ill check the FOIAXpress 

1 The four categories of records to be made available are: A. final opinions. including concurring and dissenting 
opinions, as well as orders, made in the adjudication of cases; B. those statements of policy and interpretation which 
have been adopted by the agency and are not published in the Federal Register; C. administrative staff manuals and 
instructions to staff that affect a member of the public; D. records disclosed in response to a FOlA request that "the 
agency determines have beeome or are likely to become the subject of subsetiuent requests for substantially !he same 
records. 
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system to detennine if  the request was a high profile/media request that \vent through the 
required internal and external c learance process. If the request has gone through the required 
internal and external clearance process, the designated FOIA employee will review the records 
for proper redaction. Once complete the designated FOIA employee wi l l  rename the document 
\\rith a title consistent with other documents already posted on the website. If the document is in 
Excel or Access format, the designated FOIA employee wil l  convert the file to PDF fonnat when 
possible or lock the cells in the spreadsheet in accordance with the SOP on Microsoft Excel 
Delivery Prep to prevent changes. Proceed to section IV. 

If the request \Vas not a media/high profile request that went through the internal and external 
c learance process the designated FOIA employee will review the records, rename and reformat 
as described above, then send to the Deputy FOIA Officer for review and clearance. When the 
Deputy FOIA Officer clears the records proceed to section IV . 

III. Agency ProactiYe Disclosures 

The FOIA Office often receives requests from agency program offices to post records 
proactively on the ICE FOIA Library outside of the typical FOIA process. Examples of the 
records attached to these requests include PREA Audit Reports, the Detainee Death Roster, and 
Office of Detention Oversight Facility Compliance Inspection reports. 

Upon receipt of the documents an assigned FOIA analyst will review and redact the records .  The 
highlighted and redacted versions of the document will be provided to the designated employee 
responsible for posting to the ICE FOIA Library. The designated FOIA employee will review the 
redactions and make any changes necessary. The designated FOIA employee wi l l  then rename 
the document to a title consistent with other documents already posted on the website. If the 
document is in Excel or Access fonnat, the designated FOIA employee will convert the file to 
PDF fom1at v.rhen possible or lock the cells in the spreadsheet i n  accordance w ith the SOP on 
M icrosoft Excel Delivery Prep to prevent changes. These documents will then be forwarded to 
the FOIA Officer for final review and concurrence. 

IV. Submitting Records to Web Management Services for Posting Online 

Upon concurrence/clearance that the documents are ready for posting the designated FOIA 
employee wi l l  send an e-mail containing the document(s) as attachment(s), the suggested tit le of 
the document(s), and the menu location where the shoul d  reside and who the FOIA Officer 
or Deputy FOIA Officer) cleared the records to (bl(5);(b)(7)(C) From there 
ICE Web Management Services wi l l  post the document to the website and will confinn when 
posting is complete . 

V. Reporting Requirements 

The FOIA office i s  required to report on a weekly, monthly, quarterly, and annual basi s  the 
number and page counts of al l  proactive d isclosures by the FOIA office posted for public review. 
The designated FOIA employee responsible for posting documents to the ICE FOIA Library wi l l  
maintain a spreadsheet contain ing the date the documents were posted, the title of the document, 
the page count, and the menu location \vhere the records were posted. 

Updated l 0/24/20 l 7 
1 1 120117 

Page 66 or 129 

52 

file ( 



If the designated FOIA employee for posting records on the ICE FOIA Library is  not the same 
designated employee for reporting, then numbers will be forn1arded to all required parties 
accordingly. 

VI. Removal of Posted Records 

If at any time it is determined that a document needs to be removed from the ICE FOIA Library 
an e-mai1 should be sent to l(b)(G):(b)(l)(C) 

I identifying the document for 
removal along with the menu location of the document. ICE Web Management Services \Viii 

send a confirmation e-mail when the document is removed. 

Updated 1 0/24/201 7  
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I acknowledge that I have read, understand, and follow the FOIA Office Standard Operating 
Procedures and agree to be held fully accountable for the information presented. 

Employee Signature Date 

Supervisor/Witness S ignature Date 

Updated 1 0/ 1 0/201 7  
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FOIA Xpress Input 
QualX FOIA Team 

Setting Preferences {first time only): 

1. log on to FOIA Xpress 
2. From the home screen, go to Preferences under User Options 
3. In Preferences, 

a. Change Records per Page to 99 
b. Change pages to View at a time.,. to 99 
c. change Fill Mode for Redactions to Translucent 
d. choose Redation/Border Corlor and Back Color for redactions 

i. Qua IX Analysts will use True Red and light 
ii. Qua IX Reviewers will use Cobalt Blue Border and light blue fill 
iii. ICE Reviewers use Green (FP) or Pink (CPK) 

e. Choose ICE FOIA for Request Type 
f. Choose PDF Image for Document Delivery Output Format 
g. Check the following boxes: 

i. Unlock locked Folders When User Logs Out 
ii. Show Review Flags 
iii. Enable Auto Save for Review Layer 
iv. Display Redaction Codes by Selected Order 
v. Draw Redaction Using Double Click 

h. choose default exemption codes (hold down Control Key and choose K2, b6, b7c) 
4. Once changes have been made, dick Save 

Input: 

1. On S :  drive, choose electronic case file and move into Analyst Work Folder in Qua IX folder 
a. DHS backlog cases are already input and uploaded into FOIA Xpress. Need paper file for 

FOIA Xpress Case Number. These cases need to be assigned to an Analyst. <Need 
fbl(6) (b)(7)(C) I to bulk these cases to 

b. ICE/Orlando backlog cases are electronic cases in QualX Folder on S: drive or require 
scanning pages into an electronic case folder. Paper folder in Liz's cube. These cases 
need to be input and uploaded. 

c. Once all backlog cases are done, choose new cases from FIPS file following Project 
Manager's directions regarding weekly expectations for number of cases and case sizes. 

2. In S: drive, open Request Letter file on screen to input information from the G-639 or G-28. 
During training, you may want to print the pages for your reference. 

3. In FOIA Xpress, go to Home screen 
4. Click Requester Icon on left panel 
5. In last Name field, type *[requester last name] (Example--*Smith) 
6. Click Search 

a. If search comes up empty, select New 
b. If requester ls found, highlight the appropriate requester and continue to step 9 

7. After selecting New, fill in the following information pertaining to the requester: 
a. Prefix: Mr. or Ms. 
b. First Name and Last Name 
c. Organization/Company: If Applicable (Example: Law Offices of ... ) 
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FOIA Xpress Input 
QualX FOIA Team 

d. Default Category is ALWAYS Private Individual 
e. Address Information 
f. Phone Number: If provided 
g. Email: If provided 

8. After filling in Requester information, click Save and answer Yes at the prompt 
9. Make sure the correct Requester is highlighted 
10. Click Create Request (all the info you just entered should be populated in the fields) 
1 1. In the General Information tab, 

a. the Requested Date is the date on the G-639 
b. the Received Date is today's date 

12. In the Other Information tab 
a. type the NRC Number from the Referral Memo in the Legacy Case Number field 
b. DHS and ICE/Orlando backlog cases that were assigned an old FOIA case number should 

also be entered in the legacy Case Number field 
(Example: NRC2013123456 2013FOIAXXXXX) 

c .  Type the number of pages referred from the Referral Memo i n  the Additional 
lnformaiton field ( intentional misspel l i ng). This is how QualX wil l track case size. 

13. Select the Request Information tab and in the large blank box write as followed: records 
pertaining to (subject's name). 

14. Select the yellow paper clip icon and select Browse 
a. Find the Request Letter within your analyst folder on the S:drive and select Open 
b. Find the Referral Memo within your analyst folder on the S:drive and select Open 
c. Select Attach File and select OK for each document 

15. Click Save and answer Yes at the prompt 
16. Go to Home and dick on your Primary Assignments (All the cases assigned to you will appear on 

the screen. The one you JUST created should appear at the top.) 
17. Write this case number on the paper folder ! I 
18. Under the Actions option, select Assign Request 

a. Primary-choose Analyst's name 
b. Secondary-choose ICE-CON-QC; make sure both Liz and Korrina's names have the box 

checked. Uncheck the boxes that on the right that send an email notification. 
c. Click Assign 

19. Verify Consent and Perfect the case 
a. Check G-639 for signature 
b. If signature ok, on the Primary Assignments section, select Actions and click on Perfect 

Request 
c. Make sure dates are correct when case is to be perfected 
d. Click Save and status of case should have changed to Perfected on the Primary 

Assignments screen 
e. If signature not ok, see PM for guidance 

20. Save 
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ICE FOIA STYLE GUIDE FOR PROCESSING 
USCIS ALIEN FILE REQUESTS- ORLANDO 

SEGREGABILITY - RELEASE ALI. NON-EXEMPT INFORMATION 

1 .  Presumption in favor of release; openness prevails 
2. Foreseeable Harm-Release WOULD cause harm 
3.  Any reasonably segregable portion shall be provided 

A RELEASE TO ONE IS A RELEASE TO ALI, 

EXEl\·IPTION 3 
(k)(2), (b)(3), (b)(7)(e) 

Protects information that Congress has specifically 
exempted from disclosure 

Most often, 
49 U.S.C. § l 1 4(r) 

Transportation Security Administration: Exempts 
Sensitive Security Information (SSI) the disclosure of 

which ,vould be detrimental to security of transportation 

EXEMPTION 5 
(k)(l) , (b ) (5) 

Protects 
Deliberative Communications 

2. Attorney Work-Product* 
3. Attorney-CHent Communications 

Usually documents are segregable 

***Just because the form says "Attorney \Vork 
Product" or "FOL\ Do Not Release" does not 
necessarily indicate that this exemption applies to 
the document. READ CAREFULLY!*** 

EXEMPTION 7Ce) 
(b)(7)(e) 

Protects sensitive Law Enforcement techniques and 
procedures 

• 
• 

• 

• 

• 

• 

• 

• 
• 
• 
• 
• 

• 

• 

• 
• 

• 

• 
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NO FLY-found on TECS Report 
TIDE-�refers to terrorist watch/no fly l ist, found in 
remarks on TECS report 
49 U.S.C. § 1 1 4(r) Transportation Security 
Administration 
18 U.S.C. § 3509(d) (Federal Victims' Protection 
and Rights Act) : Certain records containing 
identifying information pertaining to children involved 
in criminal proceedings 
3 1  U.S.C. § 5319 (Bank Secrecy Act) : Look for 
"Financials" i n  TECS records 
See also list of statutes published by DOJ: 
httn: //www.iustkc.iwv/oin/excmntion3.ndf 
I ncludes some memorandums/emails betv,teen OHS 
attorneys where "I believe", "I  recommend", "my 
opin ion" arc stated to suggest a course of action or 
policy 
Attorney Worksheets/Attorney Work�Product 
GEMS Attorney Report 
TA (Trial Attorney) Worksheet 
Attorney Notes 
Used when a government attorney makes a note that 
discusses strategy of a case�v.rhat the attorney plans 
on doing, opposing, other case strategy that might 
apply 
May also be used on asylum hearing notes (often 
handwritten) 
May include attorney ,,.·ork products such as 
handv,'rittcn notes, drafts of briefs, copies of ,v estLaw 
pages, other cases, or anything used to prepare for a 
case 
Computer soft keys (e.g., PF7, F l =Help) 
Database codes on header and footer of DACS reports 
(e.g., CLOS, EOIR) 
Codes on header of TECS reports (e.g., T2M RGO, TID 
#) 
URLs to Federal govemment la\v enforcement 
databases 

1 
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ICE FOIA STYLE GUIDE FOR PROCESSING 
USCIS ALIEN FILE REQUESTS- ORLANDO 

EXEMPTION 6 
(k)(2), (b)(6), (b)(7)(c) 

PERSONALLY I DENT[FlABLE INFORMATION 
(PU) 

PH is information that i s  personal in nature and which 
can be used on its own, or \.vith other infonnation, to 

identify an individual. 

INFO PERTAINING TO THIRD PARTY 

Includes Law E nforcement personnel, government 
attorneys, family members, and some information 

about the subject 
(See also RULE of NAMES section) 

NOTE: On 1-213 form only, ok to release name of 
deceased mother/father 

ALL THIRD PARTY PERSONALLY IDENTIFIABLE 
INFORMATION (PU) 
• Names and initials 
• A-Numbers 
• Street address, be sure to include Suite #, Floor #, or 

Building # if part of address 
• Date of Birth (DOB) 
• The last four digits of Social Security numbers 
• Phone numbers (withhold last 4 digits) and any 

extensions 
• Email addresses 
• Work information 
• Government-issued IDs (e.g., Driver's  license, passpm1 

numbers, car VIN number, car license plates) 
• Photos or fingerprints of third party 
• Receipt numbers from USCIS applications and 

petit ions ( ex. Starts 'With WAC, SRC, M SC, or LIN) 
• Bond Number/Bond Receipt Number/Bond Breach 

Number/Power of Attorney Number--only \\then 
held by a third party, either individual or bond service 

LA \V ENl<'ORCEMENT/THIRD PARTY PH 
• Suite numbers, room numbers, and tloors of all DHS 

addresses and a l l  DHS phone numbers and extensions 
that are not public 

• Badge number, star number, shield number of lmv 
enforcement officer 

• Code login identifiers 
• Lmv Enforcement�assigned numbers assigned to third 

party 

INFORMATION ABOUT THE SUBJECT 
• Any A�numbers not provided on the request 
• Any Alias names not. provided on the request (see also 

the RULE OF NAMES) 
• Any DOB not provided on the request 
• Subject's Social Security number, if not provided on 

the request 

2 
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ICE FOIA STYLE GUIDE FOR PROCESSING 

USCIS ALIEN FILE REQUESTS- ORLANDO 

EXEl\ilPTION 7 
(k)(2 ), (b )(7)(E)  

RELATES TO LAW ENFORCEMENT 
CODES AND PROCEDURES 

• FBI Number-ALWAYS redact entire field with 
heading, e,'en if blank) 

• Federal ORI Codes- begins with state abbreviation 
followed by 3-letter agency code and then a 4-digit 
number (ex. WVFBIO00 I ); state and local OR] codes 
are releasable l(b)(7)(E) 1 • Fingerprint Reports: Redact Fingerprint 
scores/Fingerprint pattern codes/Database (Sys) used; 
also Status remarks if they refer to a match, no hit 
found, A-number, or event number. The actual finger 

.__ ____________________ _. print should be released. Read carefully!  
• Any DHS or La,,v Enforcement system checks that are 

Also withhold as Jaw enforcement information: 
• S-Visa/Form 1-854 ---given to alien providing 

information/acting as confidential infonnant/\vitness. 
• T-Visa/Forms 1-914, 1-914 Supplement A­

immigration protection for victims of hmnan 
trafficking; also T- I nonimmigrant status 

• U-Visa/Forms 1-918, 1-929----immigration protection 
for cooperating victims of certain crimes 

TERRORISM 
{k}{2}. {b}{'}{e} 

(b)(l)(E} 

b)(7)(E) 
• Detainee Classification System/Escort Threat 

Assessment/Background check l ists 
• Case Number (Federal level only, not state or local) 
• Event Number (the Encounter N umber/ E ID/ and 

External System ID should be released) 
• Person I D  (but NOT Subject ID)  
• Operation names (e.g., Operation Janus) 
•kb )(7)(E) �redact the body of the report 

depending on infonnation, read carefully 
• Request ID # on any query reports 
• FDU Refe1ral Number· · ·Fraud Detection Unit 
• BFU Number·---Benefit Fraud Unit 
• Mention of Special Interest Country ( e.g .. Iran) 
• "US-Visit Watchlist lnfommtion Exists" or any 

Lookout reference 
• �b )(7)(E) �vithhold 

title and segregate report as necessary 
1(b)(7)(E) 

J 
WIF using k2, b7E 

• Interpol Worksheets-WIF 
• �b)(7)(E) [see also 

TERRORIS M} 
• A TS-P-----Automated Targeting System-Passengers 

(database) 

• JTTF (Joint Terrorism Task Force) 
• (b)(l)(E) 
• 

• 

3 
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ICE FOIA STYLE GUIDE FOR PROCESSING 
USCIS ALIEN FILE REQUESTS- ORLANDO 

ACTlVrnES • (b)(7)(E) 
Refer to Project Manager with any questions • 

• 
• 
• 
• 

• 
• 
• 
• 

FINANCIAL • FINANCIALS on TECS Rcport-,vithhold/segregate 
(k)(2), (b)(3), (b)(7)(c) from text as necessary 

0 refer to ICE i f  specific operation or 
Withhold all mentions of law enforcement financial i nvestigation is mentioned or ongoing 

checks • 31 U.S.C. § 5319 (Bank Secrecy Act): Look for 
sec also Exemption 3 section "Financials" in TECS records 

• If you see FIN CEN records, immediately stop 
processing and ref er to the DC Office. 

• Currency Transaction Reports (CRT), cunency 
Monetary Instrument Reports (CMIR) and other Bank 
Secrecy Act information 

• H IFCA High Intensity Financial Crimes Area 
FUGITIVE • FUGITIVE 

• Fugitive Operations or J<'UG OPS 
Fugitives, under the INA, do not have a right of access • Outstanding warrant for deportation 

to records through a FOIA request. • ABSCONDER or ABS 
• NO SHOW' for deportation/removal 
• FAIL URE TO SURRENDER or FTS 

Send all Fugitive check requests to l\·tegan Davis in the • FAILURE TO APPEAR or FT A-failure to appear 
ICE FOIA Office. for court proceedings docs NOT necessarily indicate 

fugitive status. Failure to appear to depo1tation/removal 
MIGHT indicate fugitive status 

• Referral to LESC as an Absconder 
• NCI C  Unit \Vorksheets as Absconder 
• Case Category SB-Fugitive 
• Case Category SB-ICE Fugitive 
• Bond Breached 

4 
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ICE FOIA STYLE GUIDE FOR PROCESSING 
USCIS ALIEN FILE REQUESTS- ORLANDO 

OK TO REL EASE 

In  general, 
• release the subject's own information (PU) to him 

or his attorney of record 

• release state and local l aw enforcement codes and 
information 

• release business names, addresses, phone numbers; 
letterhead-protect people, not companies 

• something published or previously released to the 
public (i.e., news articles, press releases, published 
government memorandums, public websites) 

• Google it! If  you can find it on line, it is releasable 

• Subject's address and phone nurnber (current or 
former) as long as c learly associ ated with subject If 
same address associated with third party, then 
withhold 

• Ok to release names, addresses, phone numbers, emails, 
and letterhead infr1m1ation for any attorney who 
represented the subject. 

• Subject's own FIN or FINS number 
• Alien's own medical records and the medical 

professional names/ini tials signing them. Law 
enforcement officer names within these records are 
to be \'11ithheld. 

• NCIC offense codes 
• Purpose Code on TECS reports 
• DACS Number/NAILS  Number/NIC Nmnber 
• Case Category/NCIC level/Classification 
• Method of Apprehension/G-23 line code 
• SEVIS number and School ID 
• Category Level 
• IDENT number 
• Sections of lmv 
• Fax numbers; toll-free numbers 
• Acronyms for government agencies 
• State ID numbers/ Cll number 
• State and Local ORI numbers 
• State and Local law enforcement codes 
• Business name, address, and phone number/Letterhead 
• Correction facil ity/deportation faci lity name and 

address 
• Booking number/ Prisoner number 
• Bond Number IF  bond held by SUBJECT of the FOIA 

request 
• Lopez-Mendoza vs. INS--cited at interrogations and 

questioning 
• CIMMDA and EARM-MIG 
• CAP or 287g program 
• Secure Communities or SC program and PEP. 
• Law cases used as reference, anything already 

published 
• Name of Notary Public (See RULE of NAMES) 
• Business Taxpayer ID Number or EIN Number 
• Subject's HIV Status EXCEPT when in custody (per 

Bureau of Prisons) 
• Bond Obligor's name. Redact the last four numbers of 

their Social Security number or Tax ID. 

5 
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ICE FOIA STYLE GUIDE FOR PROCESSING 
USCIS ALIEN FILE REQUESTS- ORLANDO 

IMPORTANT NOTES 
• Any investigative memos from ICE to another agency (usually USCIS) are NEVER, EVER included 

in the document� Extract those pages as nonresponsive to the FOIA request. 

• Travel information/flight number/ticket information for agents escorting an a1ien-withhold in full 
(WIF') the entire page using k2, b6, b7C, b7E. 

• ICE may only process ICE records-see Project ,Manager for referring non-agency records to the 
appropriate agency 
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ICE FOIA STYLE GUIDE FOR PROCESSING 

USCIS ALIEN FILE REQUESTS- ORLANDO 

THE RULE OF NAMES 
In general, all third party names/initials and all Lu\'· Enforcement names/initials are ·withheld. 
This always includes: 

• L iving Family members-parents, children, spouses, siblings 
• Other al iens 
• Acting D irector, Interim D istrict Director, Assistant Field Office Director (AFOD), or Assistant Special Agent in 

Charge (ASAC) 
• Specia l  Agents (SA)/Deportation Officcrs(DO)/Immigration Enforcement Agents (IEA) and their shield numbers 
• Investigators 
• Border Patrol agents 
• Translators 
• Employees 
• Government attorneys, assistant chief counsel (ACC), trial attorneys (TA), general counsel 

Releasable Names include 
• Public officials-if elected or appointed position (i.e., mayor, senator, US Attorney General) 
• DHS officials-District Director, Field Office Director (FOD), Special Agent in Charge (SAC) 
• Immigration Judge ( IJ )  and Chief Counsel (CC) 
• Notary Public 
• Medical professionals (found on the subject's medical fonns only)--doctors, nurses, physician assistants, medical 

techs \Vho provide care/meds or sign medical forn1s 
• Attorney of Record or any attorney who represents or represented the alien 
• Any names l isted as part of a firm's letterhead i s  considered "public" 
• Consuls/Consular of a foreign country, Attaches 
• Warden 
• Individuals named on the [CE public organizational chatt (see htt ://www.ice. ov/about/leadershi j) 
• County Clerk 
• Bond Obligor 
• Deceased individual's names 

Other Name Rules 
• Obvious misspelling of a letter or two---ok to release 
• Phonetic spelling (sounds alike but spelling different)-ok to release 
• Names changed to their English equivalent (ie., M iguel to :rv1ichael, Jorge to George)---0k to release 
• Some cultures use 2 last names, either hyphenated or not, that may include father's and mother's last narne. Use 

the al ien's name as provided on the G-639 for input. On documents, if you can confim1 that any of the names used 
on the documents, regardless of order or variation, correspond \Vith the surnames of the father, mother, or spouse 
provided on the G-639, then the name may be released. Also OK to check 1-2 1 3  in case documents for family 
surnames used by the subject. 

• M iddle names are releasable, even if  not provided on the FOIA request 
• I f  the alien provided an alias on the G-639, that name is releasable. 
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The Freedom of Information 

Act, 5 U.S.C . § 552 

(FOIA) 

Catrina Pavlik-Keenan, FOIA Officer 

Fernando Pineiro, Deputy FOIA Officer 
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What is the FOIA? 

What is the FOIA process? 

What is your role in 
ensuring Agency 

compliance? 

FOIA ''Best Practices'' 
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What is the FOIA ? 

• The FOIA a l lows any person the right of 
access to Federal  Government Records. 

• Enacted i n  1 966 , the purpose of the FOIA is to 
ensure an i nformed cit izenry. 

• The FOIA is a means by wh ich citizens can 
fi nd out what the i r  Government is do ing with 
the i r  tax dol lars . 

• FO IA is about transparency and accountab i l ity. 
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Who can submit a request? 

• Any person or  organ ization can submit a 
request. Th is i ncludes :  

■ The Publ ic (U .S .  C it izens and Non-Citizens) 

■ Federa l  Employees 

■ I nterest Groups 

■ News Organ izat ions 

■ Bus inesses 

■ Fore ign Governments 

• Fugitives do not have a right of access. 
• Federa l  Agencies do not have a right of 

access. 
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What can they request? 

• Al l Federa l  Government Records are 
subject to the FOIA. Th is i nc ludes but is 
not l im ited to : 

■ E-Ma i l  

■ Reports , Briefing Documents 

■ Personne l  F i les ,  Med ica l  F i l es ,  Payrol l F i les 

■ Text Messages,  Voicema i l , V ideo 
Record i ngs 

■ I nvestigative F i les , Handwritten Notes 

■ Contracts 

■ Draft Documents , Meet ing M i nutes 

■ Database Records 

■ Al ien Fi les : USCIS 
Page 84 of 1 29 



What is released? 

• There are n ine categories of i nformation 
that are exempt from mandatory disclosure 
u nder the FOIA. I nformation that fa l ls under 
one or  more of these categories wi l l  be 
redacted and withhe ld from pub l ic d isclosure .  

• FO IA requesters are entitl ed to a l l  non-exempt 
portions of the documents .  

• There are a lso th ree specia l  law enforcement 
excl us ions that protect sens it ive law 
enforcement i nformation . 
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The FOIA Exemptions 

• Exemption 1 :  Protects Classified I nformation 
• Exemption 2 :  Protects i nformation re lated 

solely to the i nterna l  personnel  ru les and 
practices of an agency. 

• Exemption 3 :  Protects i nformation that 
Congress has specifica l ly exempted from 
d isclosure ;  for examp le ,  Sens it ive Secu rity 
I nformation . 

• Exemption 4 :  Protects bus iness confident ia l  
i nformation and trade secrets obta i ned from 
compan ies and i nd ividua ls  do ing bus i ness with 
the Government .  
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The FOIA Exemptions 

• Exemption 5 :  Protects ( 1 ) De l i berative 
Commun ications , (2) Attorney Work-Product ,  
and (3) Attorney-Cl ient Commun ications .  

• Exemption 6 :  Persona l  Privacy I nformation : 

■ Names 

■ Socia l  Security Numbers 

■ Date of B i rth 

■ Al ien Numbers 

■ Other Persona l ly I dent ifiab le I nformation 
(P I I )  
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The FOIA Exemptions 

• Exemption 7 :  The Law Enforcement (LE)  
Exemption : 

■ 7(A) : Protects records perta i n i ng to open , 
ongoing , or  prospect ive LE i nvestigations . 

■ 7(B) :  Protects i nformation that wou ld  
deprive a person of a fa i r  tria l . 

■ 7(C) :  Protects P I I i n  LE Records .  

■ 7(0) :  Protects confidentia l  sou rce 
i nformation . 

■ 7(E) :  Protects sens it ive LE techn iques and 
procedures . 

■ 7(F) :  Protects i nformation that cou ld 
endanger an i nd ividua l  i f  d isclosed . 
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The FOIA Exemptions 

• Exemption 8 :  Protects i nformation perta in ing 
to the regu lat ion of ban ks .  

• Exemption 9 :  Protects i nformation perta i n ing 
to wel ls and i nfrastructu re i nformat ion . 
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The Law En/ orcement 
Exclusions 
• Excl usions a l low the Government to te l l  the 

requester that " no records exist" when in  
fact there may be thousands of respons ive 
records. Th is  is to protect records that fa l l  i nto 
the fo l lowing categories :  

• Excl usion (C)(1 ): Protects i nformation 
perta in i ng to open , ongoi ng , or prospective LE 
crim ina l  i nvestigations when the subject has no 
idea that he/she is be ing i nvestigated . 

• Excl usion (C)(2): Protects i nformation 
perta in i ng to confidentia l  i nformants when the 
i nvo lvement of the Cl in a crim i na l  i nvestigation 
is  not pub l ic ly known . 

• Excl usion (C)(3): Protects certa i n  FB I  
records .  
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The Glomar Response 

• The Glomar response a l lows the 
Government to "neither confi rm or deny" 
the existence of records . 

• The Glomar response may be used to protect 
an i nd ividua l ' s  privacy and/or certa in  class ified 
records .  
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The Privacy Act 

• The Privacy Act defines (1 ) how the 
Government may col lect P I I  of ind ividuals,  
(2) how the Government m ust protect that 
P I I ,  (3) how the Government may d isclose 
P I I ,  and (4) how the Government d isposes 
of P I I .  

• Under the d isclosure provis ions of the Privacy 
Act, any ind ividua l  has a right of access to 
records about h imself/herself; for example :  

■ Personne l/Payrol l F i les 

■ Background I nvest igation F i les 

■ Database Records 
• The FO IA and Privacy Act work together. 
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What is the FOIA Process? 

• The FOIA Request is rece ived at I CE .  
• The FO IA Office logs the request, ass igns a 

tracki ng number, and sends a letter 
acknowledg i ng rece i pt of the request 

• The FO IA Office tasks the Prog ram Office(s) 
that wou ld  reasonably be expected to have 
records that wou ld  be responsive to the 
request. 

• The Program Office conducts an adequate and 
documented search for records and provides 
al l respons ive documents to the FO IA Office . 

• The FOIA Office reviews the documents page 
by page ,  word by word , and app l ies the FOIA 
Exemptions to the documents .  

• The FO IA Office d iscloses a l l  non-exempt 
portions of t l1�
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What is an Adequate 
Search ? 

• You m ust search in  a l l  locations that 
respons ive documents wou ld l i kely be 
located . Th is i ncl udes but is not l im ited to : 

■ E-Ma i l  

■ Paper F i les 

■ Computer/Laptop F i l es 

■ Office Shared Network Drives 

■ Databases 

■ Contractors 
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How Do I Document the 
Search ? 

• You m ust fu l ly complete the FOIA Search 
Form provided by the FOIA Office. 

• The form asks for i nformation such as : 

■ Where you searched 

■ How you searched 

■ What search terms you used 

• You must s ign  and date the form . 
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FOIA Tasking Coversheet 
Department Of Homeland Security/Immigration and Customs Enforcement 

Freedom Of Information Act (FOIA) Request Suspense Tracker 

FOIA Case No.: Date: 

To: 

Suspense Date (lnforrnat,on required in the FOIA Office): 

The FOIA Office received a request from: 

(See request for further descnphon) 

If you have any questions, call the FOIA office at o r  

Attachment (s): SEE REQUEST 

Signature 

INSTRUCTIONS FROM FOIA OFFICE; (Check all that apply) 

-- Search your records for responsrve document(S), and tf located, provide one (1) clean ..... 
electronic or pa per (preferably electronic), to: FOIA Offoce - 800 North ca pita I StreetXb )(

6
): (b )(7 )( C) I Washington, DC 20536 (H your search locates voluminous records, please contact mis oruce wnn 

estimated number of pages and times to process records before the suspense date,) 

- - Record the time spent searchingfcoordinating on the request and the number of pages copied on 
the enclosed fee calculabon form. 

COMMENTS FROM FOIA COM PONENT. (Check a/I /hat apply) 

_ _  NO RECORDS-Our search failed to locate the responsive document(s). 

_ _  We believe other olfioe(s)lcomponent(s) or aoother ager,cy should be involvec in processing this 
request; recommend you contact: 

IN EACH AND EVERY CASE YOU MUST SUBMtT VERBIAGE ON HOW YOU SEARCHED AND FOUND THE 
DOCUl>'l::NTS OR IF YOU SEARCHED AND FOUND NO RECORDS. PLEASE PROVIDE THE NAl>'I::, GRADE, JOB 
TITLE AND TELEPHONE NUMBER OF THE PERSON OR PERSONS THAT CONDUCTED THE SEARCH. IF YOU 

HAVE ANY QUESTIONS PLEASE CONTACT THE FOIA OFFICE AT . 

THANK YOU IN ADVANCE FOR YOUR COOPERATION IN THIS MATTER. 

CATRINA M. PAVLIK-KEENAN 

wr
6

);(

b

)(7)( I 

IMMIGRATION AND CUSTOMS ENFORCEMENT 

FREEDOM OF INFORMATION ACT OFFICER 

OFFICE OF ASSISTANT SECRETARY 

---------------The following statement must be signed by the appropriate oomponent/offioe chief. 
I certify that all appropriate files have been searohec and all resoonsive docu . ~ � oeen reviewed, copied and 
provldec to the FOIA Office · 800 North Capital Stree snington, DC 20536. 

(Na me/Title) (Grade) (Phone #) (Date) 
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The FOIA Request 

rb )(6) ;  (b )(7)(C) 

From: 

Sent: 

To: 

Subject: 

l(b)(6) ; (b)(7)(C) I 
Tuesday, January 17, 2012 12:32 PM 
ice-foia@dhs.gov 
FOIA Request 

Under the Freedom of Information Act, 5 U.S.C. 552 and Privacy Act, 5 U .S.C. 552a , I request access to the following 
records: 

1. Copies of all TECS records pertaining to me 
2. Copies of my Official Personnel File 
3. Copies of all OPR investigations pertaining to me 
4. Copies of al l e-mails sent or received by my supervisor that conta in my name 

John Smith 
555 Main Street 
Washington, DC 55555 
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FOIA Search Criteria Form 
II 

Submit by Ema II l ._l __ Pr_ln_t_F_o_,_,,_, _ _. 

Dir·cctions for Conducting a Search tO,· R<"cords R.eque-sted Under FOI A 

ln responding to Lhis rt:-qucst for in.fonnation made pursuant to the Frt;i.:don1 of ln.fonnation 
Act., 5 S 55� you m ust undcr1.akc a search that is reasonably calculated to lJ.ncove,· all 
relevt:1nt docu111ents described in the:: n:quc:st. You must search in all places ,.vherc r-c::sponsivc 
r·ccords may bo found. 

"Records,, include: paper records, electronic records, email co1Tespondence, pictures, DVDs, 
video tapes, audio tapes, microfiche, or any other material recorded i_n any Luan11er. 

Please complete the folio ing and return to the FOIA regardless of , hether you locate any 
responsive records : 

Nan1e: 

Positiorl/Tille: 

Date search for reoord5 commenced: >===="'"""' 

Time spent conducting your search : 

D,,u,b,ues 

Date search recordor; ended: I,._=====""' 

Did you search any Svstcms of Records ( i.e., DACS, TECS, a RlME, A-file, GSA, COSI, 
GEMS, etc.)? I No I 

Which Systems of Recor·ds did you se.arch? 
\.Vhat search terms did you use? 

Why did you choose those terms? (i.e.� name of case, name of operation� name of 
alien, etc.) 

Pa11er Files 

Did you search any paper· files? f .. N,,.o"==,........ 
\.Vere the paper files your personal files? LIN,.,."o'--_ _. 
\.Vere the paper files your office's central file system? �• N=o--� 
How are your paper files organized and maintained? (i.e., file cabinet, bookshelf, 
alphabetical by lien name, operation name, etc.) _____________ _ 
How did you conduct your search? (i.e., manual hand search) _ _ _ _ _ _ _ _  _ 

Desktop/L<1ptop Co11ip11-ter 
Did you search your computer (i.e., Desktop, hard drive, share drive)? �I N_o __ � 

How did you se.,:nch your computer (i.e.� manual revie,,v of e�ch folder individually� 
use Scar·ch engine in the Start Menu, or some other electronic search command)? 

What search terms did you use? 

Why did you choost:: those terrns? (i.e.� name of case. name of operation, name of 
alien, etc.) 
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FOIA Search Cost Form 

R.,; ORI) F FREW0M OF 11'-f'0RM;\" 1011 A T (FOIA) PR "ESSI COST 

1. Request Nwuber 

I 
2. Type of R

o
· uest (✓ bo.'<) 

I 
3. Dute 

I 
.f. Action Oftice 

0 a. Initial b. Appeal Completed 

5. Clerical Hours Fee Code Total Hours Hourly Rote Co,1 

•- Search I 
b. Reviev,r 2 " 16.00 -
C. Other administr.uive Co.st 3 

6. Professional Hours Total Hours Hourly Rate Cost 

•- Search I 
b. Revie,v 2 " 32.00 = 

C. Other administrative Cost 3 

7. M,rnai,,rlal Uou r'S Total Hours Houl'!y Rate Cosr 

a. Search 
b. Rcvieur 2 X S.fl.00 -
C. Other administr..11ive Cost 3 

8. Compute,· Seu-ch )';umber Aclual Co,r Co>I 

a. Ma chine T irne I 

9. Office Machine Ti.me Total Hours Ilourly R.ite CoSI 

b. Pages reproduced for file copv 3 " . 10 = 
C. Otl1er administrative Cost 3 X . 10 = 

10. Computer P,-oduct Output/ !\umber Aclual Cosl Co,1 Actual Cost 
a. Tape/Disc/CD 4 

1 1 .  Other Administrative Fees Kumbcr Actu.,l Cost eo,t 

a. Al l postage/administrative 3 

12. Audio i\late1fals Kurnbcr Aclual Cost Cosr 

a. Materials Reproduced 
Fee- Codn: 1 3. FOR fOIA OFFICE USE ONLY 

1 .  D-inrgenble to ..,commercial� requesters; cha.rgeable to a. Total Coll.:<lable Fees - -- -
.. other"' requesters an.er deducting 2 hours. b T otsl Processing F ,es - -- -2. Oio.rg�ble to .. commercial reque,s1ers only. C. Total Charged - - --3. Nol chru-gcabli} to nny fee c1uegary d Fees Waived/Reduced (circle one) - -- -4. Oio.rg�ble 10 all fee categories.. No delltions. • Fees ot Applrcabl• (circle ooe) ----
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Why is Documenting the 
Search So Important? 

• ICE may be requ i red to prepare a 
declaration that describes i n  deta i l  how the 
Agency searched for records. 

• Fa i l u re to conduct an adequate and 
documented search may resu lt i n : 

■ A second search for records 

■ A court ordered deposition 

■ Fi nes aga inst the Agency 
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Recent Changes to the 
FOIA 
• The Open Government Act : F ines lev ied i n  

FOIA cases wi l l  be pa id d i rectly from Agency 
appropriated funds .  

■ At ICE ,  fi nes wi l l  be pa id by Program 
Offices that are responsi b le for defic iencies . 

• Pres ident Obama's FOIA Memorandum:  
Agencies M ust Adopt a Presumption of 
D isclosure 

■ I ncreased Transparency 

■ Proact ive Disclosure of I nformat ion 
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FOIA ''Best Practices '' 

• Be carefu l about personal use of 
government e-mai l ,  cameras , video, phone 
messages, and text messages. 

• Fol low approved records schedu les. Retain  
records on ly as long as you need to. 
Question on retention? Contact the ICE 
Privacy and Records Office. 
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Questions? 
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FOIA Office Contact 
Information 

• Phone :  (866 ) 633- 1 1 82 
• Fax :  (202 ) 732-4265 
• Ema i l : I CE-FO IA@d hs .gov 
• On the Web :  

■ www . ice .gov/fo ia  
■ www.d hs .gov/fo ia 
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SETTING PREFERENCES (FIRST TIME ONLY) 

1. log on to FOIA Xpress 
2. From the home screen, go to Preferences under your name in the top right corner (ex: "John 

Smith") 
3. In Preferences, under General 

a. Change Records per Page to SO 
b. "Receive Job Email Notifications" box has been checked 
c. click Save 

4. In Preferences, under Request: 

a. Send Correspondence Default Email Address: Requester Email 
b. Search Option: All 
c. Requester Search by Created Date: Descending 
d. Request Search by Created Date: Descending 
e. Move the following fields to Selected Request Fields 

i. Request# 
ii. Requester 
iii. Primary User 
iv. Review Status 
v. Assigned Date 

f. Click Save 

5. In Preferences, under Document: 

a. Change Pages to View at a Time in Document Tree to 100 
b. Image zoom factor: 50% 
c. Redaction code{s}: (b}(6), (b)(7)(c) 
d. Fill mode for Redactions: Translucent 
e. Font for Redactions: Arial 
f. Font size for Redactions: 8 
g. Redaction/Border Color for Redactions: Dark color 
h. Back color for Redactions: light color 
i. Redaction Code Alignment Preference: Top Left 
j. Default Format for Delivery/Save: Single Folder 
k. Document Delivery Output Format: PDF Tagged (508 Compliant) 
L Boxes for Draw Redaction Using Double Click, Show Review Flags, and Display Redaction 

Codes by Selected Order should all be "checked" 
m. Click Save 

6. In Preferences, under Review Object: 

a. Change the Straight Line width to 3 and the color to red 
b. click Save 
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Choose a Case 
1. On S: drive; choose electronic case folder and move (not copy) into Analyst Work Folder. 

The priority order for processing is: 
a. Oldest first. 

2. From the S: drive; open the Request letter file on screen to review and input information from 
the G-639 or G-28. (During training, print the pages for your reference.) 

Search Requester 
3. In FOIA Xpress, click Requesters icon on menu panel and select Search Requester 
4. In the Search Requester window, enter either the law firm name under Organization or the 

requester's last name behind the asterisk. 
Example: *Law Offices of John Smith OR 
Example: *Smith 

5. Click Search (below) 
a. If search comes up empty, select New {go to step 6) 
b. If requester is found, highlight the appropriate requester and click on Review History to 

check for duplicate requests regarding the same subject. If no duplicate requests are 
located, go to step 9. 

Create a New Requester 
6. After New, fill in the following information pertaining to the requester: 

a. Prefix: Mr. or Ms. 
b. First Name and Last Name 
c. Organization/Company: If Applicable (Example: law Offices of ... ) 
d. Default Category is ALWAYS Private Individual 
e. Address Information 
f. Phone Number: If provided 
g. Email: If provided 

7. After filling in Requester information, click Save and answer Yes at the prompt 
8. Make sure the correct Requester is highlighted 

Create Request 
9. Click Create Request (all the info you just entered should be populated in the fields) 
10. Enter the Requested Date (the date on the G-639) 
11. Under Description, type "records pertaining to Subject's Full Name, (A#)" [Note - if no A# is 

provided, use date of birth) No end-of-sentence period is necessary, that is automatically 
incorporated into the templates. 

12. Also under Description, Drag and Drop the incoming request and NRC referral memo into the 
"Drag and Drop Zone" 

13. Under Sub Requests, type the NRC Number from the Referral Memo in the Legacy Case Number 
AND USCIS Referral Number fields 

14. Click Save at the bottom 

Assign Case 
15. From the individual case screen, click on Assign Users located on the left hand menu options 

2 

Page 107 of i 29 

Orlando FOIA Team SOP 

selecting 

5-15-2017 



16. As the analyst, your name should be both the "Request Owner" (if you created the case) and the 
"Primary User". To add a secondary user (ex: sending a case to your supervisor for review or 
assigning for a fugitive check): 

a. Click Add Users located in the middle of the screen 
b. Type in the first name of the person you would like to add under Personal Information, 

First Name and click on Search 
OR 
Scroll through the list of names provided and select the box next to the person you 
would like to add and click Select 

17. Uncheck the boxes under Send Email (unless you have specific instructions you are adding) 
18. Click Assign at the bottom right 
19. Click Yes to confirm the assignment or No to return to the screen to make changes 
20. Click OK 

Verify Consent and Perfect the Case 
21. Check G-639 for appropriate signatures. If signature is not ok, see PM for guidance. 
22. Click Set Perfect Status, then click save button. 

UPLOADING CASE DOCUMENTS 
Verify that the number of pages received is the same number of pages that were referred on the NRC 

Referral memo. If the page count is off, contact your supervisor before uploading and processing the case 

further. 

1. From the individual case screen, click Add/Search/View Documents from the left hand menu 
options 

2. Click Add Documents to upload new documents 
3. Under Option for Adding Pages, select the radio button next to "Add all files to a single folder" 

and type in the same FX folder number that appears below (ex: 2017-ICFO-12345) 

4. Drag and drop the responsive documents into the Drag and Drop Zone OR select Attach Files 
(within the Drag and Drop Zone) to browse your computer and select the files 

5. Click Add 
6. Click Yes 
7. The responsive records will appear under "Review Log Documents" - check the box next to the 

file and click on Open Documents below 
8. In a separate tab, the Review Log will pop up. Maximize the document tree on the left-hand 

side to reveal all the pages. 
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Orlando FOIA Team SOP 

PROCESSING THE CASE DOCUMENTS 

FUGITIVE CHECK: Do this step BEFORE redacting the case, See FUGITIVE PROCEDURES section. 

fixing Pages 
1. The first page of the documents and any page that is difficult to read must be stamped with Best 

Available Copy. 
a. Click on the Stamp icon on the right toolbar and select BEST AVAILABLE COPY 
b. Draw a box at the bottom of the page. Best available copy will fill the box automatically. 

2. Rotate pages right-side up as necessary using icons on the right toolbar. 
3. Use the deskew icon on the top tool bar to better align the text of a page. 

Redacting 
4. Choose the Redact icon from the right toolbar. Draw a box around the information with your 

cursor. The default exemptions (b6, b7c) will automatically fill the box. 
To change the exemption codes: 

a. Right click on the redaction box and select Redaction Codes 
b. Uncheck the default codes and check the new exemptions codes 
c. If you select exemption b3, a pop-up box asks for the statute. Select 49 U.S.C. § 114(r}. 
d .  Click OK to close the box. 
e. Check the redaction box to be sure the correct exemptions appear in the box. 

5. After finishing the first page, a menu pops asking if you want to create a Review Layer. Select 
Yes and name it Highlighted Copy as the Review Layer, and select OK. 

6. Next to each page number in the panel on the left side of the screen are Review Flags that 
describe the status of the page: 

a. <Not Reviewed>: this page has not been reviewed for redactions 
b. <Reviewed>: this page had something added to the page but no redactions were applied 
c. <Disclosed in Part>: this page has been reviewed and redactions are applied to a part of 

the page 
d. <Released in Full>: this page has been reviewed with no redactions 
e. <Withheld>: this page has been reviewed and the entire page is being withheld in full 

7. To Release a Page in Full: 
a. Right click on the page itself or on the page number in the left-side panel 
b. Choose Review Flag in the pop up menu 
c. Select Released in Full 

8. To Withhold a Page in Full: 
a. Right click on the page itself or on the page number in the left-side panel 
b. Choose Redact in Full in the pop up menu 
c. The page will appear shaded and the default exemption codes will appear on the page 
d. Change the exemption codes as needed by right clicking on the page again and following 

the same instructions as above. 
e. Check the page to be sure the correct exemptions appear 
f. Assign the correct Review Flag 

9. Once you have finished the last page of the case, make sure to select off the last page so it can 
save properly 

10. Look at the Review Flag for every page in the panel on the left side of the screen to be sure that 
every page was reviewed and reads as Disclosed in Full, Released in Full, or Withheld. No Review 
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Flag should read <Not Reviewed> or <Reviewed>; correct any pages to show that they have 
been reviewed. 

lL Once you have finished with the redactions and it has been properly saved, select the Close icon 
from the top toolbar (the last icon) 

CREATING THE RESPONSE LETTER 
1. From the individual case screen, select Correspondence from the left-hand menu options. 
2. Under the Send Correspondence tab, select Letter Template from the options on the right Click 

on Select Letter Template and choose the correct template, below are a few examples: 
a. ICE Response to Requester (USCIS Referral) - for USCIS Referrals 
b. ICE Response to Requester (Fugitive Disentitlement) - for positive fugitives 
c. ICE Response to Requester (USCIS Withheld in Full) - for USCIS referrals that are 

completely withheld 
3. Click on Customize for Final Response 
4. Once the letter has loaded, proofread it carefully and make any corrections. 
5. Select Save For Final Response 
6. Once letter has been saved, check the Correspondence Log that the status for the letter is 

Pending for Final Response; if it reads Pending, you must delete the letter and create a new one 

CHANGE CASE REVIEW STATUS TO 3. REDACTION gc AND ASSIGN TO gc 

1. From the individual case screen, select More Actions from the left-hand menu options. 
2. Click on Change Review Status 
3. From the drop down menu next to Set Request Status to: select 3. Redaction QC 
4. Click Save 
5. Click OK 
6. Assign to your supervisor, see "Assign Case" section in SOP 
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MANAGING THE ANALYST'S PRIMARY ASSIGNMENTS QUEUE 
1. Cases stay in the Analyst's Primary Assignments queue until the case is finalized and closed. 
2. The Review Status tracks who has the case and what needs to be done with it (see table below). 
3. The Analyst can only see and work on cases that are assigned to them. 
4. Analyst work flow priority is: 

a. Closing cases with Review Status "4. Close out" 
b. Correcting any cases Reassigned for Corrections 
c. Processing al l  cases assigned 

Review Status 
{blank) 
Pending Fugitive Check 
3. Redaction QC 

Reassigned for Corrections 

Branch Chief Review 

Means 
This case is waiting to be processed by the Analyst 
Case is on hold pending results of fugitive check 
Analyst has processed the case and submitted it to 
QC for review 
QC has reviewed the case and reassigned it back to 
the Analyst for Corrections 
QC has reviewed and sent the case for Director 
Review 

Signature Required/Correspondence Final Response letter needs ICE signature {This status 
is used for fugitive response letters or special cases 
requiring a letter only) 

4.Close Out Case is ready for Analyst to Finalize and Close 

6 
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FINALIZING THE CASE: 
Confirm that the case status is "4. Close Out". 
Note: Using the Next button action tabs, during the closing process is more efficient. 

Finalize Review Layer and Move Docs from the Review Log to the Request Folder 
1. From the individual case screen, click Add/Search/View Documents 
2. Check the box next to the documents under "Review Log Documents" and click Open 

Documents 
Click on the case folder and when prompted, select and load the final, approved review layer 
(Highlighted Copy) 

3. Open the tree to see all the pages. Check that All pages have a review flag. 
4. Right click folder on the case folder 
5. Click Add Folder(s) To 
6. Select Request Folder 
7. In the pop up box, the file name should appear in the Request ID box. In the Select Folder(s) 

section, click so all 3 folders are checked. Click Add Folder{s) 
8. A Review Status option will pop up, select Yes then OK when it says the files have been added. 
9. Another pop up box asks if you want to set Review Status, select "no" 
10. Close Document Management from icon 

NOTE: The case status will have changed from Perfected to Documents Added. 

Finalize Exemptions 
11. From the individual case screen, select Final Actions 
12. In the Final Actions box, the request description, Action, and Exemption Codes should be 

prepopulated. (If the Actions field reads TBD, ask the PM for assistance before going further.) 
13. Under "Discretionary Releases", select No (Our cases will always be NO) 
14. Select Save 

NOTE: The case status will have changed from Documents Added to Disposition Accepted 

Document Delivery 
Use the Document Delivery system to e-mail final responses with records. If not using Document Delivery 
to email, you still must complete the Document Delivery section with a different delivery mode, either CD 
or Mail. This is the only way that the system can track what records were released and when they were 
released. 

18. From the individual case screen, select Deliver Documents on the left-hand menu 
19. Click "Deliver documents" (which will be the first option) 
20. A Documents Delivery screen should open displaying the case documents. Click the document 

tree box to open the folders so you see all the pages. 
21. Check the box to the left of the case folder. All pages should now be checked as well. Be certain 

there is a checkmark next to every page (unless it is a duplicate page - those do NOT get 
delivered) 

22. Click the Deliver Documents icon on the toolbar at the top of the screen and the Document 
Delivery for Request screen will open. Choose Delivery Options by clicking drop down box for 
Delivery Mode box and choose E-mail. The Requester's email (if available) should appear. 
Continue with instructions for Delivery Mode E-mail (below). 

23. If no Requester email appears, you must send the case by CD or  by Mail. Click on Close at the 
bottom of the box to get out of the Deliver Documents mode WITHOUT delivering documents, 
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and continue to follow instructions for Delivery Mode CO and Diskette OR Delivery Mode Mail 
{below} 

Delivery Mode E•Mail: 
a. Check the final Response letter box, Select Default/Pending final Response letter 
b. Click on the Customize and Save button to open the Signed Response letter 
c. CHECK THE LETTER CAREFULLY! Review the letter for any necessary corrections and 

confirm that the letter has been signed, then click Save and OK 
d. Choose the "ICE Response Email" response and click on customize to review the 

email being sent. Click save. 
e. Include Review Objects: Make sure that there is a check next to the Stamp box. No 

check box next to Comments Box, Ellipse, or Sticky Note. 
f. Check box for Include Fully Redacted Pages 
g. Check box for Black & White 
h. Choose Bates Stamp and use case number as prefix; Preview Pages to check 
h. Output format should be PDF Tagged (508 Compliant) 
i .  Check the box for password protection 
j. Go to Step 23 to continue 

Delivery Mode CD and Diskette: ff no email for requester and there are more than 21 

pages of case documents, then save the case documents to a disk and mail with the 

Response Letter. 

a. From Documents Delivery page (all pages still checked), dick the file folder and then 
click on the Save to Disk icon at the top tool bar 

b. Path: save to your desktop, then click OK 
c. Format: PDF Image 
d. Page Range: All 
e. Redactions: Include Redacted and Non Redacted Pages and check Include Fully 

Redacted Pages 
f. Fill Mode: Opaque 
g. Include Review Object: Check next to Stamp 
h. Select Bates Stamp and use case number as prefix; Preview Pages to check 
i. Click OK to save to disk 
j. Click Yes to open the file. Rename the file to match the case number if necessary. 
k. Burn the file to a disk (follow prompts on your computer) and write the name of the 

case on the disk. Make sure the file name and the disk name are the same as the 
case number. 

L After burning the disk, open and check the disk to make sure the case is readable. 
Put the disk in a CD envelope. 

m. From Documents Delivery Screen, click on Deliver Documents icon at top toolbar 
n. Select Customize and Save the Final Response letter to open the letter. Print the 

signed Response letter. Put disk and letter in manila envelope. Write the address on 
the outside. 

o. Select CO and Diskette for Delivery Mode. 
p. Go to Step 23 to continue .. 
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Delivery Mode Mail: Use this method if there is no email for the requester and there are 
1-20 pages of case documents OR if the request is going to a detention center (Jail Mail). 
Always pr int two-sided (change your printer settings). Mail the case documents with the 
Response letter. 
a. From Documents Delivery page, click print icon at top tool bar 
b. Page Range: All 
c. Include Review Object: click Stamp 
d. Choose Bates Stamp and use case number as prefix, Preview Pages to check 
e. Click OK to print documents 
f. Click on Deliver Documents icon at top tool bar 
g. Select Customize and Save the Final Response letter to open the letter. Print the 

signed Response letter. Put letter and printed pages in appropriate envelope. 
h. Select Mail for Delivery Mode 
L Go to Step 23 to continue. 

23. After completing the Document Delivery section, click Deliver Documents. A message will pop 
up telling you that "Job# is being processed and an email notification will be sent to you when it 
is complete." If you "printed" the documents, they will be sent to you in a zip file through email. 

24. Close Documents Delivery screen using the Close icon to return to Primary Assignments screen. 
25. NOTE: The case status will have changed from Disposition Accepted to Delivery Pending. You 

MUST wait until you received the email notification from DHS that the documents have been 
successful ly delivered before you can do to the next step. Once you receive the email 
notification, the case status will change from Delivery Pending to Documents Delivered. 

Close the Case 

23. From the individual case screen, select Close Request on the menu 
a. The box next to Closed Date, fill in the date the case was closed (today's date} 
b. For Review Status, clear status 
c. No. of Pages Released and No. of Pages Reviewed should be pre-populated and be the 

same value 
d. Select Save and select No to fees associates with this request 
e. Select Yes if you are sure you want to close the case {once closed, no editing can be 

done to the case) 
f. NOTE: Once the case has been closed properly, the case wil l disappear from your 

Primary Assignments screen. 
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FUGITIVE PROCEDURES 

Check for Fugitive Status 
L Review ALL the documents for fugitive status. Refer to Check for Fugitive Status flowchart 
2. If the case documents suggest that the subject could be a fugitive, change the case review status to 

Pending fugitive check, assign the case t (b)(6):(b)(?)(C) as a secondary user. 
3. Go on to another case until the case status c anges to 'Review-Other" (positive fugitive) or 

"Returned from Remote Review of Documents" (negative fugitive) 
4. If the subject is NOT a fugitive, the analyst will process the case documents as usual. 
5. If subject is a fugitive, remove the case documents from the Review Log. No documents will be 

processed or sent to the Requester. The analyst will prepare the Fugitive Response Letter and 
submit the case to QC for review. 

Finalizing a Fugitive Case 
6. Confirm that the case status is "4. Close out" 
7. Select Final Actions. A pop up box will ask if you want to do this without adding any documents, 

answer yes. 
8. On the Final Actions screen ,  double click where it says TBD. Another box will open.  In the Action 

field choose Other Reasons then scroll down to the bottom of the list of reasons and select Other­
Fugitive Status. Click on Apply at the bottom toolbar. 

9. Back on the Final Actions screen, confirm that the request information now reads fugitive status 
then click on Save at the bottom toolbar. The case status will have changed to Disposition Accepted. 

10. Select Deliver Documents ➔ Deliver documents and attach the signed Fugitive Response letter the 
same way as a standard response letter (you are only sending the signed Fugitive Response letter; 
no case documents) 

11. Deliver the letter (either email or print the letter and mail it) and close the case following the usual 
procedures in the SOP. 

10 
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ICE FOIA STYLE GUIDE FOR PROCESSING 
USCIS ALIEN FILE REQUESTS- ORLANDO 

SEGREGABILITY = REL EASE ALL NON-EXEMPT INFORMATION 

1 .  Presumption i n  favor of release; openness prevai ls 
2 .  Foreseeable Harm- Release WOULD cause harm 
3.  Any reasonably segregable portion shal l  be provided (DO NOT BLANKET REDACT) 
4. Ensure that the documents you are reviewing match exactly the FOJA request, first and last name and DOB, to avoid a 

privacy breach. Consult a supervisor if necessary 

A RELEASE TO ONE IS A RELEASE TO ALL 

EXEl\1PTION 3 
(b)(3), (b)(7)(e) 

Protects information that Congress has specifically exempted 
from disclosure 

l\fost often, 
49 U.S.C. § I 1 4(r) 

Transportation Security Administration: Exempts Sensitive 
Security Infonnation (SSI) the disclosure of,vhich would be 

detrimental to security of transportation 

EXEMPTION S 
(b)(S) 

Protects 
1. Deliberative Communications 
2. Attorney 'Work-Product* 
3.  Attorney-Oient Communications 

Usually documents are segregable 

***Just because the form says "Attorney \\''ork Product" 
or "FOlA Do Not Release" docs not necessarily indicate 
that this exemption applies to the document. READ 
CARE FULL "\'." !*** 

• NO FLY-found on TECS Report 
• TIDE-refers to terrorist watch/no fly l ist, found in remarks 

on TECS report 
• 49 U.S.C. § IJ 4(r) Transportation Security 

Administration 
• 18 U.S.C. § 3509(d) (Federal Victims' Protection and 

Rights Act) : Certain records containing identifying 
information pertaining to children involved in criminal 
proceedings 

• 31  U.S.C. § 531 9  (Bank Secrecy Act): Look for 
"Financials" in TECS records 

• See also list of statutes published by DOJ: 
httn:i/v,wv.-·. iustice.llov/oin/exemntion3 .ndf 

• Includes some memorandums/emails between DHS attorneys 
where "I believe", "I recommend", "my opinion" are stated 
to suggest a course of action or policy 

• Attorney Worksheets/Attorney Work-Product 
• GEf>.·1S Attorney Report 
• TA (Trial Attorney) Worksheet 
• Attorney Notes (READ NOTES FOR CONTENT TO 

RELEASE} All fi.tctual information within immigration notes 
are releasable 

• Used when a government attorney makes a note that 
discusses strategy of a case-what the attorney plans on 
doing, opposing, other case strategy that might apply 

• May also be used on asylum hearing notes (often 
handwritten) 

• May include attorney work products such as bandwTitten 
notes, drafts of briefs, copies of Westlaw pages, other cases, 

�------------------------,f---_or_._an�1 "'-'th_in,g used to prepare for a case 
• Computer soft keys (c.g.j(b)(l)(E) l EXEl\·fPTION 7(e) 

(b)(7)(e) 

Protects sensitive Law Enfo1·cement techniques and 
procedures 

Revised as of 08/01/17 approved by G ILD 

• Database codes on header and footer of DACS reports (e.g., 
l(b)(7)(E) I 

• Codes on header ofTECS reports .fb)(l)(E) I 
• URLs to Federal government la'w enforcement databases 
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ICE FOIA STYLE GUIDE FOR PROCESSING 
USCIS ALIEN FILE REQUESTS- ORLANDO 

EXEl\•'IPTION 6 
(b)(6), (b)(7)(c) 

PERSONALLY IDENTIFIABLE INFORMATION (PII) 
PI I  is information that is personal in nature and which can be 

used on its 01.vn, or with other information. to identity an 
individual . 

INFO PERTAINING TO THIRD PARTY 

l.ncludes Law E nforcement personnel, government attorneys, 
family members, and some information 

about the subject 
(See also RUL E  of N AMES section) 

NOTE: On 1�21 3  form onlv, ok to release name of deceased 
mother/father 

Revised as of 08/01/17 approved by G ILD 

ALL THIRD PARTY PERSONALLY IDENTIFIABLE 
JNFORMA TION (PU) 
• 
• 
• 

• 
• 
• 
• 
• 
• 

• 
• 

Names and initials 
A-Numbers 
Street address, be sure to include Suite #. F loor #, or 
Building # if part of address 
Date of B irth (DOB) 
The last four digits of Social Security numbers 
Phone numbers (\vithhol d  l ast 4 digits) and any extensions 
Email addresses 
\lv'ork information 
Government-issued IDs (e.g., Driver's license, passport 
numbers, car VIN number, car license plates) 
Photos or fingerprints of third party 
Receipt numbers from USCIS applications and petitions (ex . 
Starts with \VAC, SRC, MSC, or LIN) 

• Bond Number/Bond Receipt Number/Bond Breach 
Number/Po-wer of Attorney Number�only ,vhen held by a 
third party (this would be a family  member or friend usually) 

• Any private party that bonds out individuals should be 
released but their social security numbers may be 
withheld 

• AnJ individual signing for a FOD or SAC 

LAW ENFORCEMENTffHIRD PARTY Pll 
• Suite numbers, room numbers, and floors uf al l  DHS 

addresses and a l l  OHS phone numbers and extensions that 
arc not public 

• Badge number, star number, shie ld number o f l av,r 
enforcement officer and canine officer badge numbers 

• Code login identifiers 
• Law Enforcement-assigned numbers assigned to third party 
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ICE FOIA STYLE GUIDE FOR PROCESSING 

USCIS ALIEN FILE REQUESTS- ORLANDO 

EXEl\'IPTION 7 • 
(b)(7)(E) 

• 
RELATES TO LAW ENFORCEMENT 

CODES .AND PROCEDURES 
• 

(b)(7)(E) 

• 

Also withhold as law enforcement information: 
• S-Visa/Form 1�854--given to alien providing • 

information/acting as confidentia l  infonnant/witness. 
• T-Visa/Forms I-914, 1-914 Supplement A--immigration • 

protection for victims ofhmnan trafficking; also T- 1 • 
nonimmigrant status 
U-Visa/Forms 1-918, 1-929-immigration protection for • • 

• 
cooperating victims of certain crimes • 

• 
• 
• 
• 
• 

• 

• 
• 
• 

FBI Number-ALWAYS redact entire field with 
heading, even if blank) 
Federal ORI Codes- begins with state abbreviation 
fol lowed by 3-letter agency code and then a 4-digit number 
(ex. WVFBIO0O l ); state and local ORI codes are releasable  
Fingerprint Reports: Redact F ingerprint scores/Fingerprint 
pattern codes/Database (Sys) used; also Status remarks if  
they refer to a match, no hit found, A-number, or event 
number. The actual finger print should be released. Read 
carefully! 
Any OHS or Law Enforcement system checks that are nm 

[
b)(7)(E) 

Detainee Classification System/Escort Threat 
Assessment/Background check l ists 
Case Number (Federal level only, not state or local ) 
Event Number (the Encounter Number/ ElD/ and External 
S:ystem I D  should be released) 
Person ID (but NOT Subject ID) 
Operation names (e.g., Operation Janus) 

�b)(7)(E) �redact the body of the report 
depending on information, read carefully 
Request JD # on any query reports 
FDU Referral Number- Fraud Detection Unit 
BFU Number•• •Benefit Fraud Unit 
Mention of Specia l  Interest Countty ( e.g., Iran) 
"US-Visit \Vatch l ist Infonnation Exists" or any Lookout 
reference 

�b)(7)(E) !withhold title 
and segregate report as necessary 

l(b)(7)(E) !WIF using k2, b7E 
Interpol \Vorksheets--WIF 

�b)(7)(E) tsee also 
TERRORISM)  

• A TS-P --Automated Targeting System-Passengers (database} 

Revised as of 08/01/17 approved by GILD 
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ICE FOIA STYLE GUIDE FOR PROCESSING 
USCIS ALIEN FILE REQUESTS- ORLANDO 

(b)(7)(E) 

TERRORISl\l 
{b)!?)je} 

Refer to Supervisor with any questions 

F'INANCIAL 
{b}(3), (b)(7)(e) 

Withhold all mentions of law enforcement financial checks 
see also Exemption 3 section 

fi'UGIHVE 

'Fugitives, under the I NA, do not have a right of access to 
records through a FOJA request. 

Please follow guidance issued bJ GILD related to the Fugith·e 
Disentitlement Doctrine SOP 

\, 'JI I d l(b)(fi);(b)(l)(C) •· • d" "d I th . 'ou w1 on y sen fll
r.::;;;;:;;;::;:;:T,";;r,;::;:;;;:,1

,1, ,or m 1v1 ua s at 
h ave submitied FOIA request m1·ec11y to ICE for their record 

Revised as of 08/01/17 approved by G ILD 

• JTTF (Joint Terrorism Task Force) 
• b)(7)(E) 
• 

• 

• 

• 
• 
• 
• 
• 
• 
• 
• 
• 
• 

• 

• 

• 

• 
• 
• 
• 
• 
• 
• 
• 

• 
• 

FINANCIALS on TECS Report-withhold/segregate from 
text as necessary 

o refer to ICE if speci fic operation or investigation is  
mentioned or ongoing 

31 U.S.C. § 53 19 (Bank Secrecy Act): Look for 
"Financials'· in TECS records 
If you see FIN CEN records, immediately stop processing 
and refer to your Supervisor. 
Currency Transaction Reports (CRT), currency Monetary 
Instrument Reports (Cl'vHR) and other Bank Secrecy Act 
infommtion 
HIFCA = High Intensity F inancial Crimes Area 
FUGITIVE 
Fugitive Operations or FUG OPS 
Outstanding i,tarrant for deportation 
ABSCONDER or ABS 
NO SHOW for deportation/removal 
FAILURE TO SURRENDER or FTS 
FAI LURE TO APPEAR or FTA-fai lure to appear for 
court proceedings does NOT necessarily indicate fi.1gitive 
status. Failure to appear to deportation/removal M IGHT 
indicate fugitive status 
Referral to LESC as an Absconder 
NCIC Unit Worksheets as Absconder 

• Case Category SB-Fugitive 
• Case Category SB-ICE Fugitive 
• Bond Breached 
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ICE FOIA STYLE GUIDE FOR PROCESSING 
USCIS ALIEN FILE REQUESTS- ORLANDO 

OK TO RELEASE 

I n  general, 
• release the subject's own information (Pll) to him or his 

attorney of record 

• release state and local law enforcement codes and 
information 

• release business names, addresses, phone numbers; 
letterhead-protect people, not companies 

• something published or previously released to the public 
(i.e., news articles, press releases, published government 
memorandums, public websites) 

IMPORTANT NOTES 

• Subject 's address and phone number (current or fi.ffmer) as 
long as clearly associated with subject. If same address 
associated with third party, then withhold 

• Ok to release names, addresses. phone numbers. emails. and 
letterhead information for any attorney who represented the 
subject. 

• Subject's own FIN or FINS number 
• Alien's mvn medical records and the medical professional 

names/initia ls signing them. Law enforcement officer 
names within these records are to be withheld. 

• NCIC offense codes 
• Purpose Code on T ECS reports 
• DACS Number/NAILS Number/NIC  Number 
• Case Category/NCIC level/Classification 
• Method of Apprehension/G-23 line code 
• SEVIS number and School ID 
• Category Level 
• lDENT number 
• Sections of lavv 
• Fax numbers; toll-free numbers 
• Acronyms for government agencies 
• State I D  numbers/ CH number 
• State and Local ORI numbers 
• State and Local law enforcement codes 
• Business name, address, and phone number/Letterhead 
• Correction facil ity/deportation facility name and address 
• Booking number/ Prisoner number 
• Bond Number ff bond held by SUBJECT of the FOIA 

request 
• Lopez-Mendoza vs. INS-cited at interrogations and 

questioning 
• CHvlMDA and EARM-J\,UG 
• CAP or 287g program 
• Secure Communities or SC pro6rram and PEP. 
• Law cases used as reference, anything already published 
• Name of Notary Public (Sec RULE of  NAMES) 
• Business Taxpayer ID Number or EIN Number 
• Subject's HIV Status EXCEPT when in custody (per Bureau 

of Prisons) 
• Bond Obli.gor's Tax I D  if i t 's a business number 

• Any investigative memos from ICE to another agency (usually USCIS) are NEVER, EVER included 
in the document. Extract those pages as nonresponsive to the FOIA request. 

• Travel information/flight number/ticket information for agents escorting an alien-·withhold in  full 
(WIF) the entire page using b6, b7C, b7E. 

Revised as of 08/01/17 approved by GILD 
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ICE FOIA STYLE GUIDE FOR PROCESSING 

USCIS ALIEN FILE REQUESTS- ORLANDO 

• ICE may only process ICE records-see Supervisor for referring non-agency records to the 
appropriate agency. 

• Make sure to line out all FOUO and LES markings on FOIA releases. Please set your FOIAXpress 
settings to RED ·width 3 for lines in the preferences section. If you require assistance please see your 
sunervisor. 

(b)(7)(E) 

THE RULE OF NAl\··fES 
In general, all third party names/initials and all Law E nforcement names/initials are withheld. 
This ahvays includes: 

• Living Family members-parents, children, spouses, siblings 
• Other aliens 
• Acting Director, Interim District Director, Assistant Field Ot11ce D irector (AFOD), or Assistant Special Agent in 

Charge ( ASAC) 
• Special Agents (SA)/Dep011ation Officcrs(D0)/Immigration Enforcement Agents ( IEA) and their shield numbers 
• I nvestigators 
• Border Patrol agents 
• Translators 
• Employees 
• Government attorneys, assistant chief counsel (ACC), trial attorneys (TA), general counsel 

Releasable Names include 
• Public otlicials-if elected or appointed position (i .e., mayor, senator, US Attorney General) 
• OHS officials-District Director, Field Oflice Director (FOO), Speci al Agent i n  Charge (SAC) 
• Immigration Judge (IJ) and Chief Counsel (CC) 
• Notary Public 
• Medical professionals (found on the subject's medical forms only)--doctors, nurses, physician assistants, medical 

techs who provide care/meds or sign medical forms 
• Attorney of Record or any attorney ,vho represents or represented the alien 
• Any names listed as part of a firm's letterhead i s  considered "public" 
• Consuls/Consular of a foreign country, Attaches 

Revised as of 08/01/17 approved by GILD 
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ICE FOIA STYLE GUIDE FOR PROCESSING 

USCIS ALIEN FILE REQUESTS- ORLANDO 

• \Varden 
• Individuals named on the ICE public organizational chart (see h ://www.ice. ov/aboutlleadershi /) 
• County Clerk 
• Bond Obligor 
• Deceased individual's names 

Other Name Rules 
• Obvious misspelling of a l etter or t\vo-ok to release 
• Phonetic spelling (sounds alike but spelling d ifferent)-ok to release 
• Names changed to their English equivalent (ie., M iguel to M ichael, Jorge to George)-ok to release 
• Some cultures use 2 last names, either hyphenated or not, that may include fathers and mothers last names. Use 

the al ien's name as provided on the G-639 for input. On documents, if you can confirm that any of the names used 
on the documents, regardless of order or variation, c01Tespond vvith the surnames of the father, mother, or spouse 
provided on the G-639, then the name may be released. Also OK to check 1-2 1 3  in case documents for family 
surnames used by the subject. 

• Middle names are releasable, even if not provided on the FOJA request. 
• If  the alien provided an al ias on the G-639 ,  that name is releasable. 

Revised as of 08/01/17 approved by GILD 
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ICE FOIA STYLE GUIDE FOR PROCESSING 
USCIS ALIEN FILE REQUESTS- ORLANDO 

SEGREGABILITY = REL EASE ALL NON-EXEMPT INFORMATION 

1 .  Presumption in favor of release; openness prevails 
2. Foreseeable Hann- Release \:VOULD cause harm 
3. Any reasonably segregable portion shall be provided (DO NOT BLANKET REDACT) 
4. Ensure that the documents you are reviewing match exactly the FOIA request, first and last name and DOB, to avoid a 

privacy breach. Consult a supervisor if necessary 

A RELEASE TO ONE IS A RELEASE TO ALL 

EXEl\lPTlON 3 
(b)(3), (b)(7)(e) 

Protects information that Congress bas speeifically exempted 
from disclosure 

l\fost often, 
49 U.S.C. § l 1 4(r) 

Transportation Security Administration: Exempts Sensitive 
Security lnfonnalion (SS!) the disclosure of,vhich would be 

detrimental to security of transportation 

EXEMPTION S 
(b)(5)  

Protects 
1 .  Deliberative Communications 
2. Attorney \Vork-Product* 
3. Attorney�Ctient Communications 

Usually documents are segregable 

***Just because the form says "Attorney \Vork Product" 
or "FOIA Do Not Release" does not necessarily indicate 
that this exemption applies to tbe document. READ 
CAREFULLY!*** 

• NO FLY-found on TECS Report 
• 'BOE-refers to terrorist ,vatch/no fly list, found in remarks 

on TECS report 
• 49 U.S.C. § l l 4(r) Transportation Security 

Administration 
• 1 8  U.S.C. § 3509(d) (Federal Victims' Protection and 

Rights Act) : Certain records containing identifying 
infom1ation pertaining to children involved in criminal 
proceedings 

• 3 1  U.S.C. § 531 9  (Bank Secrecy Act): Look for 
"Financials" in TECS records 

• See also list of statutes published by DOJ: 
httn://www. iuslice. 2:ov/oin/exemntion3 . ndf 

• Includes some memorandums/email s  between DHS attorneys 
where ··1 believe", "I recommend", "my opinion" arc stated 
to suggest a course of action or policy 

• Attorney Worksheets/Attorne:y \'•lork-Prnduet 
• GEMS Attorney Report 
• TA (Trial Attorney) Worksheet 
• Attorney Notes (READ NOTES FOR CONTENT TO 

RELEASE) Al l  factual information within immigration notes 
are releasable 

• Used when a government attorney makes a note that 
discusses strategy of a case-what the attorney plans on 
doing, opposing, other case strategy that might apply 

• May also be used on asylum hearing notes (often 
handwritten) 

• May include attorney work products such as hand,vritten 
notes, drafts of briefs, copies of\\i'estlaw pages, other cases, 
or anvthim:1; used to prepare for a case _________ 

E_X
_

E
_

l\
_

'i
_P_T_l_O_N_7(_e_) 

_________ •_l_'_on-1""'p·u-t;; soft keys (e.g. , l(b)(7)(E) I 
(b)(7)(e) • Database codes on header and footer ofDACS reports (e.g., 

Protects sensitive Law Enforcement techniques and 
procedures 

EXEMPTION 6  
(b)(6), (b)(7)(c) 

Revised as of 5/92/17 approved by GILD 

kb)(7)(E) ! 
• Codes on header ofTECS reports (e.g.,l(b)(7)(E) I • URLs to Federal government l aw enforcement databases 

ALL THIRD PARTY PERSONALLY IDENTIFIABLE 
INFORMATION (PU) 
• Names and initia l s  
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USCIS ALIEN FILE REQUESTS- ORLANDO 

PERSONALLY I DENTlFIABLE INFORMA TJON (PU) 
PIT is information that is personal in nature and which can be 

used on its o,vn, or w· ith other information, lo identify an 
individual. 

IN .F'O PERTAINING TO THIRD PARTY 

Includes Law Enforcement personnel, government attorneys, 
family members, and some information 

about the subject 
(See also RULE of NAl\1ES section) 

NOTE: On 1�213 form onlv, ok to release name of deceased 
mother/father 

Revised as of 5/92/17 approved by GILD 

• 
• 

• 
• 
• 
• 
• 
• 

• 
• 

• 

• 

A-Numbers 
Street address, be sure to include Suite #, Floor #, or 
Bui lding # if pa1i of address 
Date of B irth (DOB) 
The last four digits of Social Security numbers 
Phone numbers (\.vithhold last 4 digits) and any extensions 
Email addresses 
Work information 
Govemment-issucd ms (e.g . . Driver's l icense, passport 
numbers, car VIN number, car license plates) 
Photos or fingerprints of third party 
Receipt numbers from lJSCIS applications and petitions (ex . 
Starts with WAC, SRC, TvlSC, or UN) 
Bond Number/Bond Receipt N umber/Bond Breach 
Number/Power of Attorney Number- on ly when held by a 
third party (this would be a family member or friend usually) 
Any private party that bonds out indh'iduals should be 
released but their social security numbers may be 
·withheld 

• Any individual signing for a FOD or SAC 

LAW ENFORCEMENT/THIRD PARTY PI I  
• Suite numbers, room numbers, and floors of all DHS 

addresses and a l l  DHS phone numbers and extensions that 
are not public 

• Badge number, star number, shield number of lmv 
enforcement officer and canine officer badge numbers 

• Code login identifiers 
• Law Enforcement-assigned numbers assigned to third party 

lNFORMA TlON ABOUT THE SUBJECT 
• Any A-numbers not provided on the request 
• Any Alias names not provided on the request ( see also the 

RULE OF NAMES) 
• Any DOB not provided on the request 
• Subject's Social Security number, if not provided 
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EXEl\·IPTION 7 (b)(7)(E) RELATES TO LA \\l ENFORCEMENT CODES AND PROCEDURES 
• FBl Number-AL \VA YS redact entire field with 

heading, even if blank) 
• Federal OR] Codes- begins 'With state abbreviat ion 

followed by 3-letter agency code and then a 4-digit number 
(ex. WVFBlO0O I ); state and local ORI codes are releasable 

• Fingerprint Reports: Redact Fingerprint scores/Fingerprint l(b)(7)(E) I pattern codes/Database (Sys) used; also Status remarks i f  they refer to a match, no hit found, A-number, or  event 
number. The actual finger print should be released. Read carefully! 

�-----------------------� • Anv DHS or Law Enforcement svstem checks that are nm 

Also withhold as law enforcement information: 
• S-Visa/Form 1-854--given to alien providing 

information/acting as confidentia l  infonnantiwitness. 
• T-VisalForms 1-914, 1-914 Supplement A--immigration 

protection for victims of human trafficking; also T- 1 
nonimmigrant status 

• U-Visa/Forms 1-918, 1-929-immigration protection for cooperating victims of certain crimes 

Revised as of 5/92/17 approved by GILD 

(b)(7)(E) 

• Detainee Classification System/Escort Threat Assessment/Background check lists 
• Case Number (Federal level only, not stale or local) 
• Event Number (the Encounter Number/ E ID/ and External 

System ID should be released) 
• Person I D  (but NOT Subject ID) 
• Operation names (e.g., Operation Janus) 
• l(b)(7)(E) �redact the body of the report 

depending on information, read carefully 
• Request I D  # on any query reports 
• FDU Refenal Number- Fraud Detection Unit 
• BFU Number-••· ··•Bencfit Fraud Unit 
• Mention of Special Interest Country (e.g., Iran) 
• "US-Visit Watch list Infonnation Exists" or any Lookout 

reference 
• !(b)(7)(E) hvithhold title 

and segregate report as necessary 
• �b)(7)(E) ! Wl F  using k2, b7E 
• Interpol \Vorkshcets-WIF 
• !(b)(7)(E) [see also 

TERRORISM) 
• ATS-P · •Automaled Targeting System-Passengers (database) 
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ICE FOIA STYLE GUIDE FOR PROCESSING 
USCIS ALIEN FILE REQUESTS- ORLANDO 

TERRORIS/VI 
i h}{7)(e} 

• JTTF (Joint Terrorism Task Force) 
• (b)(7)(E) 

�-----------------------,1 • 

.___l

(b}U}

-

(E) �I, : 
Refer to Supervisor with any questions 

FINANCIAL 
{b)(3), (b)(7)(e) 

\�lithhold all mentions of la\V enforcement financial checks 
see also Exemption 3 section 

F'ugitives, under the INA, do not have a right of access to 
records through a FOJA request. 

(b)(6);(b)(7)(C) 
I Send all Fugitive check requests to in the ICE 

F0IA 0fficn-" ____ _. 

Revised as of 5/92/17 approved by GILD 

• 
• 
• 
• 
• 
• 
• 
• 
• 
• FINA NCIALS on TECS Report-withhold/segregate from 

text as necessary 
o re fer to I CE if specific operation or investigation i s  

mentioned or  ongoing 
• 3 1  U.S.C. § 53 1 9  ( Bank Secrecy Act): Look for 

"Financials" i n  TECS records 
• If you see FIN CEN records, immediately stop processing 

and refer to your Supervisor. 
• Currency Transaction Reports (CRT), currency Monetary 

Instrument Reports (CMIR) and other Bank Secrecy Act 
infomiation 

• HIFCA High l ntensitv Financial Crimes Area 
• FUGITIVE 
• Fugitive Operations or f'UG OPS 
• Outstanding warrant for deportation 
• ABSCON DER or ABS 
• NO SHOW for deportation/removal 
• FAILURE TO SURREN DE R  or FTS 
• FAILURE TO APPEAR or FTA-fai lure to appear for 

court proceedings does NOT necessarily indicate fugitive 
status. Failure to appear to deportation/removal MIGHT 
indicate fugit ive status 

• Referral to LESC as an  Absconder 
• NCIC Unit Worksheets as Absconder 
• Case Category SB-Fugitive 
• Case Category SE & SI-ICE Fugitive 
• Bond Breached 
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ICE FOIA STYLE GUIDE FOR PROCESSING 
USCIS ALIEN FILE REQUESTS- ORLANDO 

OK TO RELEASE 

In general, 
• release the subject's ow'n information (PII) to him or his 

attorney of record 

• release state and local law enforcement codes and 
information 

• release business names, addresses, phone numbers; 
letterhead-protect people, not companies 

• something published or previously released to the public 
(i.e., news articles, press releases, published government 
memorandums, public websites) 

IMPORTANT NOTES 

• Subject's address and phone number (current or frumer) as 
long as clearly associated ,vith subject. If same address 
associated with third party, then writhhold 

• Ok to release names, addresses, phone numbers, emails, and 
letterhead information for any attorney who represented the 
subject. 

• Subject's O\i.'n F IN or FINS number 
• Alien's own medical records and the medical profossional 

names/initials signing them. Law enforcement officer 
names within these records are to be withheld. 

• NCIC offense codes 
• Purpose Code on TECS reports 
• DACS Number/NAILS Number/NIC Number 
• Case Catcgory/NCIC level/Classification 
• Method of Apprehension/G-23 line code 
• SEVIS number and School ID 
• Category Level 
• lDENT number 
• Sections of lavv 
• Fa_x numbers; toll-free numbers 
• Acronyms for government agencies 
• State ID numbers/ CII number 
• State and Local ORI numbers 
• State and Loeal la\'l.l enforcement codes 
• Business name, address, and phone number/Letterhead 
• Correction facility/deportation facility name and address 
• Booking number/ Prisoner number 
• Bond Number ff bond held by SUBJECT of the FOIA 

request 
• Lopez-Mendoza vs. INS-cited at interrogations and 

questioning 
• ClMMDA and EARM-J\,UG 
• CAP or 287g program 
• Secure Communities or SC program and PEP. 
• Law cases used as reference, anything already published 
• Name of Notary Public (Sec RULE of  NAMES) 
• Business Taxpayer ID Number or ElN Number 
• Subject's HIV Status EXCEPT when in custody (per B ureau 

of Prisons) 
• Bond Obli_gor's Tax ID if ifs a business number 

• Any investigative memos from ICE to another agency (usually USCIS) are NEVER, EVER included 
in the document. Extract those pages as nonresponsive to the FOIA request. 

• Travel information/flight number/ticket information for agents escorting an  alien-withhold in full 
('YIF) the entire page using k2, b6, b7C, b7E. 

Revised as of 5/92/17 a pproved by G ILD 
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ICE FOIA STYLE GUIDE FOR PROCESSING 
USCIS ALIEN FILE REQUESTS- ORLANDO 

• ICE may only process ICE records-see Supervisor for referring non-agency records to the 
appropriate agency. 

• Make sure to line out all FOUO and LES markings on FOIA releases. Please set your FOIAXpress 
settings to RED width 3 for lines in the preferences section. If you require assistance please see your 
'-'Hnt>rui.:,nr • b)(7)(E) 

• 

• Anv intelligence communitv related documents must be referred back to the originating Agency ie rb)(7)(E) 1 
THE RULE OF NAMES 
In general, all third party names/initials and all La," Enforcement names/initials are \Yithheld. 
This always includes : 

• Living Family members-parents, children, spouses, sibl ings 
• Other aliens 
• Acting Director, Interim D istrict Director, Assistant Field Office Director (AFOD), or Assistant Special Agent i n  

Charge (ASAC) 
• Special Agents (SA)/Deportation Officers(D0)/Immigration Enforcement Agents (IEA) and their shield numbers 
• Investigators 
• Border Patrol agents 
• Translators 
• Employees 
• Government attorneys, assistant chief counsel (ACC), trial attorneys (TA), general counsel 

Releasable Names include 
• Public officials--if elected or appointed position ( i.e., mayor, senator, U S  Attorney General) 
• DHS officials-District Director, Field Office D i rector (FOD), Special Agent in  Charge (SAC) 
• Immigration Judge (IJ) and Chief Counsel (CC) 
• Notary Public 
• Medical professionals (found on the subject's rnedical forms only)-doctors, nurses, physician assistants, medical 

techs who provide care/meds or s ign medical forms 
• Attorney of Record or any attorney who represents or represented the alien 
• Any names l isted as part of a finn 's letterhead i s  considered "public'' 
• Consuls/Consular of a foreign country, Attaches 
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ICE FOIA STYLE GUIDE FOR PROCESSING 

USCIS ALIEN FILE REQUESTS- ORLANDO 

• Warden 
• Individuals named on the ICE public organizational chart (see http://wwv.•.ice.gov/about/leadership/) 
• County Clerk 
• Bond Obligor 
• Deceased individual's names 

Other Name Rules 
• Obvious misspelling of a letter or two- ok to release 
• Phonetic spelling (sounds alike but spelling different)-ok to 
• Names changed to their English equivalent M iguel to M ichael, Jorge to George)--0k to 
• Some cultures use 2 last names, either hyphenated or not, that may include fathers and mothers last names. Use 

the alien's name as provided on the G-639 for input. On documents, if you can confim1 that any of names used 
on documents, regardless of order or variation, correspond with the surnames of the father, mother, or spouse 
provided on the G-639, then the name may released. Also OK to cheek 1-2 1 3  in case documents for family 
surnames used by the subject 

• Middle names are releasable, even if not provided on the FOIA request. 
• If  the alien provided an alias on the G-639, that name is releasable. 
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